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CHAPTER

ONE

GENERAL INFORMATION

1.1 About the Program

ActiveMap Desktop is a part of a multi-component web-based ActiveMap system for remote
employee management.

ActiveMap is an online system for organizing the interaction between field workers and the
dispatcher (task coordinator). The system helps to plan and manage the production work
and to operationalize quality control of field services.

Capabilities of ActiveMap:

• Flexible customization to meet the needs of the company.

You can adapt ActiveMap to any business process. A list of work types, steps and deadlines
can be set up for each organization cluster.

• Adding tasks and controlling their execution.

The system allows users to add operational and planned tasks, including scheduled tasks on
a given template.

• Object inventory.

ActiveMap helps to carry out an inventory of objects: update information on the status of
existing objects, identify nonexistent, and to create new ones.

• Control of field employees.

The system helps to control employees with real-time tracking of their location, viewing the
history of their movement, and recording the execution of requests.

• Convenient and quick interaction between field employees and work coordinators.

ActiveMap speeds up the process of exchanging results between the field employee and the
work coordinator. The coordinator can promptly update task information, which is immedi-
ately communicated to the field employee. The coordinator can also quickly return the task
to the fieldworker for execution based on the results of the fieldwork.

• Using photo and video fixation materials and GPS data.

The system can verify that tasks were carried out using photos, video recordings, and loca-
tion data. This avoids the necessity of field inspection of executed orders.

• User rights configuration.

1
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The system enables the configuring of user rights. Each user is assigned a certain role. The
role of the system user determines access to the list of tasks, rights to edit and manage these
tasks. The roles vary from simple executors to the administrator of the entire system.

• Displaying service objects on a map.

ActiveMap allows users to create tasks based on service objects with the automatic filling
out of coordinates and task fields.

• Creating electronic documents.

The system allows users to create reports on the work with tasks and user activity based on
the document form of the organization, as well as invoices issued by field employees.

More information about the comprehensive capabilities of the ActiveMap system can
be found on the website of the Activemap Computer Systems Design company https:
//activemap.me/.

The ActiveMap Desktop software (hereinafter referred to as the Program) is a desktop ap-
plication that implements the client part of the task management module of the ActiveMap
software suite. Use the Program to solve the following tasks:

• Setting tasks for employees of responsible organizations (with the ability to add media
files and perform georeferencing);

• Task management and control over their execution;

• Generating analytical and statistical reports on tasks.

1.2 Software and hardware requirements

To ensure stable operation of the Program, the personal computer must have the following
minimum specifications:

• Processor – Intel Core i5 or higher

• RAM – 8GB

• Operating System – Microsoft Windows 10 and above

• Microsoft .NET Framework 4.6.1

1.3 Installing the Program

To install the program on a user’s computer, follow these steps:

1. Click the “How to start?” button on the top panel of the geoportal page in “Map” mode.

2. Select ActiveMap Desktop from the list of suggested modules.

3. Click “Download”. The setupActiveMapDesktop.exe file is downloaded.

4. Run the setupActiveMapDesktop.exe file, which calls the ActiveMap Desktop installa-
tion wizard (Fig. 1.1).

5. Click “Next” to go to the window with the license agreement text. After reading the text
of the agreement, click “Accept” to continue the installation or “Cancel” to terminate
the installation of the Program.

1.2. Software and hardware requirements 2
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Fig. 1.1: Launching the ActiveMap Desktop installation wizard

6. After clicking the “Accept” button you are taken to the ActiveMap Desktop installa-
tion folder selection window (Fig. 1.2). By default, the installation wizard suggests placing
the program file in the C:/Users/User_name/Documents/Activemap Computer Systems De-
sign/ActiveMap Desktop folder. You can choose another folder by clicking “Browse. . . ”.

Fig. 1.2: Window for selecting the folder for installing the Program

7. After selecting the folder, click “Install”.

1.3. Installing the Program 3



CHAPTER

TWO

WORKING IN THE PROGRAM

2.1 Starting the Program

After completing the installation, a window appears asking you to run the Program (Fig.
2.1). Click “Yes” to start the Program.

Fig. 2.1: Starting the Program immediately after installation

If you click “No” when prompted to start the Program, you can click the ActiveMap Desktop
shortcut, automatically created on the desktop after installation (Fig. 2.2).

Fig. 2.2: Program shortcut on the desktop

When launching the program, the system checks the versions of ActiveMap Desktop, Ac-
tiveMap Web, and Cerebellum to ensure compatibility. If the versions do not match, a cor-
responding message appears.

4
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After successful launch, the Program authorization window opens (Fig. 2.3). The client
server is listed in the login options line. Enter your username and password. In the Ac-
tiveMap Web web component you can configure the display of the “Save the password” flag
when logging in. If this setting is enabled, you can check the “Save the password” box to
save the specified username and password. Passwords are stored in an encrypted form.

Fig. 2.3: Authorization window

When launching the Program for the first time or if updates are available on subsequent
launches, a window appears after clicking “Continue”, asking you to install the update files
(Fig. 2.4).

Fig. 2.4: Update installation window

After the updates are downloaded, the Program user interface opens with a set of features
corresponding to the user’s access rights.

Data access settings are set by the administrator individually for each user depending on the
role. Roles differ from each other by the set of actions they can perform in the system. Roles
are assigned by administrators when creating user accounts. There are the following role
types:

• The System Administrator is responsible for the system configuration, including the
management of clusters, organizations, users of all roles, contracts, directories, and for
the distribution of access rights to the different layers and reports.

• The System Inspector manages the tasks of all clusters.

• The Cluster Administrator is responsible for cluster administration, namely: manag-
ing organizations and users of his or her cluster, assigning access rights to layers and
reports within the cluster, and for managing cluster tasks.

• The Cluster Inspector manages the tasks of the cluster.

2.1. Starting the Program 5
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• The Organization Administrator is responsible for administering the organization,
namely: creating users, granting access rights to layers and reports within the organi-
zation, and managing tasks of the organization.

• The Organization Inspector manages the tasks of the organization.

• The Executor creates new tasks and executes the assigned tasks in the System.

2.2 Connection settings

If internet access is provided through a proxy server, click “Connection settings” in the login
window (Fig. 2.3) to bring up the “Connection settings” window with proxy server settings
(Fig. 2.5).

Fig. 2.5: Proxy server settings

In this window you can specify the proxy settings to be used in the network and click “Ok”
to save the settings.

2.3 User interface of the Program

The Program interface includes the following elements (Fig. 2.6):

1. Toolbar – provides access to all features of the Program in the form of a standard
hierarchical menu.

2. Object search bar – allows you to search for service objects in layers.

3. Cluster selection button – allows you to switch between tasks of different clusters,
to see organizations, users, and layers available in the selected cluster. The button is
displayed only for users with the roles of System Administrator and Inspector, as well
as Cluster Administrator and Inspector if they are responsible for multiple clusters.

4. User profile – allows you to enter and change information about the current user.

5. Notifications tape – displays notifications about different events: executor’s leaving
the task area, overdue tasks and others.

6. Task search and filter area – provides the ability to filter the list of tasks for individual
needs.

2.2. Connection settings 6
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7. Task list area – contains a list of all tasks loaded into the system, taking into account
the filter applied.

8. Task information panel – shows detailed information on the task and allows editing
it.

Fig. 2.6: Elements of the main window of the Program

2.3.1 Toolbar

At the top of the Program window, there is a toolbar that contains the following sections
(Fig. 2.7):

Fig. 2.7: Toolbar

• “File”

• “View”

• “Options”

• “Filters”

2.3. User interface of the Program 7
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• “Reports”

• “Schedules”

• “Layers and tables”

• “Service objects”

• “Help”

In addition to standard sections, the toolbar may contain a “Plugins” section.

The “File” menu section contains the following tabs (Fig. 2.8):

Fig. 2.8: “File” menu section

• “Update” – updates service data used in tasks (types of work, steps, priorities, lists of
layers and rights to them) by synchronizing with the server.

• “Clear layers cache” – deletes layer data or layer files saved on the user’s PC, including
the basemap cache. When other users edit a layer, the cache is automatically cleared
when the layer is reconnected, when moving on the map, or changing the scale.

• “Clear task cache” – deletes data and task files stored on the user’s PC.

• “Exit” – terminates the work in the Program.

The “View” menu section contains the following tabs (Fig. 2.9):

Fig. 2.9: “View” menu section

• “Tasks map” – view tasks on the map in a separate window according to the geographic
location specified in the task (Fig. 2.10).

2.3. User interface of the Program 8
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Fig. 2.10: “Tasks map” window

Working in the “Tasks map” window is described in detail in the Task map (page 108) sec-
tion.

• “Select downloaded tasks” – selects all tasks displayed in the task list area.

• “Mode of work with task templates” – shows and allows you to edit task templates
created according to the schedule.

• “Use the classic view of the main window” – switches between the new task list
interface and the old one (for more information, see Task list area (page 27)).

The “Options” menu section contains the following tabs (Fig. 2.11):

Fig. 2.11: “Options” menu section

• “Loading from a GPS camera. . .” – loads tasks and photos with geographic tags (Fig.
2.12). The process of adding tasks in this way is described in details in the Creating
tasks by uploading geotagged photos (page 128) section.

2.3. User interface of the Program 9
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Fig. 2.12: Loading from GPS camera

• “Import” – loads tasks into the system from MS Excel in bulk. The section contains
second level tabs: “Import from MS Excel”, “Import template tasks from MS Excel”,
“Update tasks from MS Excel”, and “Save template” (Fig. 2.13).

Fig. 2.13: Data import

For importing tasks or task templates from MS Excel, download a template with examples,
prepare a file for import using the template, and upload the completed file into the program.
To update tasks from MS Excel, export the required tasks, make changes, and upload the
completed file using the “Update tasks from MS Excel” tool. For more information about
the task import process, see Mass task creation and updating using an Excel spreadsheet
(page 133).

Note: If the user applies a filter to the table, the system offers to load tasks using this filter.

In all standard windows for selecting or saving a file, the path is remembered in order to

2.3. User interface of the Program 10
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open the same folder when you access it again.

• “Export” – exports data to MS Excel file (Fig. 2.14).

Fig. 2.14: Data export

The data is exported taking into account the filter applied to the tasks. For more details, see
Task list area (page 27).

• “Settings” – opens the ActiveMap Desktop settings. The section contains second level
tabs (Fig. 2.15):

Fig. 2.15: “Settings” tab

• “Program settings . . . ” – opens the main program settings window, including task set-
tings, geodata, image compression parameters, task cache, notifications, and language
settings (for more details, see the Internal settings (page 58) section). The parameters
changed in the program settings window are used by default the next time the program
is opened (Fig. 2.16).

2.3. User interface of the Program 11
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Fig. 2.16: Settings window

• “Log management. . . ” – opens the window for viewing and managing logs (Fig. 2.17).
You can set the logging level and view the contents of the log files.

2.3. User interface of the Program 12
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Fig. 2.17: Viewing and managing logs

The “Filters” menu section contains the following tabs (Fig. 2.18):

Fig. 2.18: “Filters” menu section

• “Task filter” – opens a list of saved filters. To apply one of the filters, select it from
the list.

• “Save filter” – saves the current configuration of the task filter area. Working with the
task filter area is described in detail in the Task search and filter area (page 24) section.
To save the filter, enter its name and click “Save” (Fig. 2.19).

Fig. 2.19: Filter saving window

• “Restore my filter” – returns to default filter values. This tab is active if a default filter
is set. The default filter is assigned in the filter manager window.

2.3. User interface of the Program 13
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• “Cancel the filter filling when the application is launched” – disables the default
filter on application startup. This tab is active if a default filter is installed. The default
filter is assigned in the filter manager window.

• “Open the filter manager” – opens the “Filter manager” window (Fig. 2.20). Here
you can set a default filter, rename, edit, and delete existing filters. If a default filter is
set, it is highlighted in bold in the list.

Fig. 2.20: “Filter manager” window

The “Reports” menu section (Fig. 2.21) opens a window with a list of reports of “General”
type that are not linked to a specific data table or types of work. Reports with “By layers”
type are opened directly from the layer window (for more information, see Layer window
menu (page 74) section). Reports with the “By task” type are opened in the task card or in
the task list area when performing mass operations on the selected tasks (Task information
panel (page 32), Task list (page 101)).

In the report window, you can select a time interval for the report generation and the format
of the exported file (*.pdf, *.doc, *.xlsx, *.rtf). Some reports require additional parameters.

2.3. User interface of the Program 14
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Fig. 2.21: “Reports” window

To start generating a report after selecting the time interval and format of the uploaded file,
click “Create report (PDF/EXCEL/WORD(2007)/rtf)”. The “Generated reports” block dis-
plays the report generation process. When the report is ready, the file becomes available
for viewing. Depending on the selected format, you can open the report file in its default
application (for example, *.doc in Microsoft Word) and save it on your PC.

The “Schedules” menu section contains the following tabs (Fig. 2.22):

Fig. 2.22: “Schedules” menu section

• “Schedules management” – opens the “Schedule list” window for creating, searching,
editing, and deleting schedules. Schedule allows you to create tasks based on templates
at a certain point in time with the required frequency (Fig. 2.23).

2.3. User interface of the Program 15
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Fig. 2.23: “Schedule list” window

Schedule management is described in detail in the Editing schedules (page 153) section.

• “Add to new schedule” – opens the “Schedule creation” window to add tasks selected
in the list to a new schedule (Fig. 2.24).

2.3. User interface of the Program 16
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Fig. 2.24: “Schedule creation” window

The process of adding tasks to a schedule is described in the Creating schedules (page 144)
section.

• “Import schedule” – opens a window for selecting an Excel file containing information
about schedule runs. The process of importing schedules is described in the Importing
schedules (page 161) section.

The “Layers and tables” menu section opens a window with the “Layers”, “Data table”,
and “Dictionary” tabs. In each tab, you can open a tabular view of a layer, data table or
reference table (dictionary) for further editing by clicking the highlighted line or by clicking

the button. In addition, in the “Layers” tab you can enable the display of layer
groups on the map and select a base map (Fig. 2.25). Working with layers and tables is
described in Working with tabular data (page 70) section.

2.3. User interface of the Program 17



ActiveMap Desktop user manual 3.44.0 (5.48)

Fig. 2.25: “Layers and tables” window, “Layers” tab

The “Service objects” menu section contains tabs with the names of service object layers
and a tab for importing a new table with service objects from MS Excel (Fig. 2.26).

Fig. 2.26: “Service objects” menu section

Clicking any of the tabs with the name of the service object layer opens a window with a list
of objects in the selected layer and a map with their location marks (Fig. 2.27).

2.3. User interface of the Program 18
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Fig. 2.27: “Service Objects” window

When you switch to the tab for importing a table from MS Excel, a file opening window
appears. The process of searching, adding, editing, and deleting service objects is described
in detail in the Layers (page 71) section. Creating tasks linked to service objects is described
in the Creating tasks in the service object window (page 141) section.

The “Help” menu section contains one tab (Fig. 2.28) – “About the program. . .” for view-
ing information about the current and previous versions of ActiveMap Desktop (Fig. 2.29).

Fig. 2.28: “Help” menu section

Fig. 2.29: “About” window

2.3. User interface of the Program 19
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2.3.2 Object search bar

To the right of the menu sections there is a search bar for objects in layers (Fig. 2.7). When
placing the cursor in the search field, you can see the list of layers used for the search (Fig.
2.30). By default, these are service object layers.

Fig. 2.30: Extended search field for objects in layers

To exclude a layer from the search, click next to the layer name. To include additional
layers in the search, click the arrow to the right of the selected layer names – a drop-down
list of available layers appears (Fig. 2.31).

Fig. 2.31: Full list of layers available for object search

The search results display the title and subtitle of the object (Fig. 2.32).

2.3. User interface of the Program 20
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Fig. 2.32: Object search results

2.3.3 Cluster selection button

Users with System Administrator and System Inspector roles have an additional button in
the Program interface to switch between clusters. This feature is also available to Cluster
Administrators and Inspectors responsible for multiple clusters. Other users see only the
tasks, layers, organizations, and other users within their own cluster.

System Administrators and System Inspectors see the default cluster after authorization. For
Cluster Administrators and Inspectors, the system displays the cluster of their main organi-
zation upon login.

To switch between clusters, click . A window appears where you can select the required
cluster from the drop-down list (Fig. 2.33).

Fig. 2.33: Cluster selection window

After switching clusters, the task list area displays tasks created within the selected cluster.
Layers, tables, users, and organizations of the current cluster are available in the layer and
table lists, as well as in drop-down lists generated from system dictionaries.

2.3. User interface of the Program 21
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2.3.4 User profile

If you click on the user name displayed in the top right corner of the Program window, a
window with information about the current user appears (Fig. 2.34).

Fig. 2.34: User profile

You can see the following information in the window:

• User login

• Full name

• Organization

• Role

• Email

• Phone number

On the left side of the profile window, there is an avatar and a label with additional infor-
mation (such as the user’s smartphone model). To replace the avatar, click “Change” and
upload a new image from the computer. To delete the current image without replacing it
with another, click “Delete”.

Clicking on the “Edit” line opens the “Profile edited” window (Fig. 2.35).
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Fig. 2.35: “Profile edited” window

Here you can change the user’s name, user type, password, and, if authorized, email, phone
number, and user tags.

2.3.5 Notifications tape

Clicking on the “Notifications tape” line in the upper right corner opens a window that dis-
plays a list of notifications about various events: executor leaving the task area, overdue
tasks, etc. (Fig. 2.36). You can see the number of new notifications to the right of the “No-
tifications tape” line. Unread notifications are marked with one grey tick, and read ones –
with two green ticks.

Fig. 2.36: Notifications tape
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If there are no events, the window remains empty. To stop receiving notifications, click the
pause sign, to resume – the play sign. To delete received notifications, click “Clear” in the
lower right corner of the window.

2.3.6 Task search and filter area

The task search and filter area is designed to search for tasks in the general list using various
search parameters (Fig. 2.37).
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Fig. 2.37: Task search panel

In the upper part, there is a field for contextual search of tasks by the task number, title,
description, and URL generated in the task properties. To search for a task, enter the num-
ber/description of the task or part of it in the search field. The list of tasks that match the

search query is displayed (Fig. 2.38). To remove the task filters, use the or button.
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Fig. 2.38: Displaying tasks that meet the conditions in the list

Use the following sections of the filter panel for advanced filtering:

• Task’s parameters – showing favorite and first-level tasks (i.e. parent or unrelated),
search by the date of creation and update, due date, and by task overdue.

• Assigned to organization – search for the organization to which tasks are assigned
(quick search bar and selection of several organizations is available). Organizations are
grouped into clusters. In addition to selecting organizations from the list, you can use
the context menu with a list of commands used inside the “Assigned to Organization”
section:

– Select only this line.

– Select everything except this line.

– Select all.

– Reset all selected.

To open the context menu, place the cursor on the line with the organization name and right-
click (Fig. 2.39).

Fig. 2.39: Context menu in the task filter panel section

• Assigned to performer – search by the user to whom tasks are assigned (quick search
bar and multiple user selection is available). You can also use the context menu, similar
to the one described above.
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• Task’s creator – search by the user who created the tasks (multiple selections are
available).

• Creator organization – search for the organization on behalf of which the tasks are
created (multiple organizations can be selected).

• Steps – search for the selected step (multiple steps are available), you can use the
context menu to select.

• Priorities – search by the selected priority (selection of several priorities is available),
you can use the context menu to select.

• Types – search by the type of work (a quick search bar by type and selection of several
types of work is available), you can use the context menu to select and include only
non-empty types of work (types of work for which tasks were created).

• Statuses – search by the status (selection of one or all available stages is available).

• Custom fields – search by the value in the selected custom field (multiple search fields
are available).

• Service objects – search for the specified object from the layer of service objects cre-
ated in the system.

• Contracts – search for the contracts created in the system.

• Photos – search by the number of photos added to the task and comparison with the
sample photo. When searching by the number of photos, only the photos added af-
ter the task was created are taken into account, not the total number of photos in the
task. You can use quick filters to speed up the search: “Not added” (no added photos),
“Added” (there are added photos), “Specified quantity added” (greater than or equal to
the entered value). You can also apply quick filters for searching by the percentage of
photo similarity: “No marks”, “Bad”, and “Good”. You can set up the threshold level
in ActiveMap Web (the “Mobile application” -> “Comparing photos” -> “Positive per-
centage of photo comparison” section) and adjust it during the work session with the
slider. The filter is set to the minimum value specified on the task cover.

Note: The parameters are customized to suit the individual company’s business area.

2.3.7 Task list area

The central part of the Program screen displays all tasks available to the user (Fig. 2.40).
The ability to view and edit tasks depends on the user’s role in the system. When you apply
a filter, the list displays tasks that meet the specified parameters.

The new default view of the main window (Fig. 2.40) displays the following information for
each task in the list:

• Main photo with or without the rating of photo similarity (if there are attached photos
in the task);

• Number of attached files;

• Number of unread messages in the task (in the blue circle on the right side of the list);

• Color indication of lines with steps of execution.
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Fig. 2.40: Task list, new view (used by default)

In the classic view of the main window, task cards in the list are colored depending on the
steps of execution without displaying photos and the number of unread messages (Fig. 2.41).
To switch to the classic view, go to the “View” menu section and click “Use the classic view
of the main window” or set the classic view of tasks in the program settings window (more
details in the Program settings (page 57) section).

2.3. User interface of the Program 28



ActiveMap Desktop user manual 3.44.0 (5.48)

Fig. 2.41: Task list, classic view

At the top of the task list area, you can see the following buttons:

• “Create task” – adds new tasks (detailed in the Creating tasks (page 114)
section).

• “Tasks map” – opens the “Task Map” window (detailed in the Task map
(page 108) section).

• “Export to Excel” – exports the current task list with the ability to choose the
exported fields (Fig. 2.42) to a Microsoft Excel document. When exporting, the filter
and sorting parameters of tasks are taken into account (Fig. 2.43).
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Fig. 2.42: Selecting the fields for export

Fig. 2.43: Data export to Microsoft Excel

To speed up frequently performed actions on exporting, you can save the set of task fields
selected for export. To do this, mark the main and custom fields for export, click “Add”

, enter the name of the set, and click “Apply”. A message about adding an export setting
appears (Fig. 2.44). The name of the settings set is displayed in the drop-down list of saved
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configurations.

Fig. 2.44: Message about the successful addition of a new export setting

You can change , rename , or delete the saved set if necessary.

• “Sorting” – orders the general list of tasks by the date of update (this sorting is used by
default), by task number, by title, by creation date, by update date, and by the deadline
(Fig. 2.45) in ascending (by default) and descending order (Fig. 2.46).

Fig. 2.45: Selecting the type of task sorting

Fig. 2.46: Selecting the order in which tasks are sorted

You can select one or more tasks from the task list by selecting the checkboxes next to the
task number. You can also select all loaded tasks by clicking the corresponding line at the
bottom of the list area. You can see information about the number of loaded and selected
tasks next to it (Fig. 2.47). By default, 100 tasks are loaded. To select more, scroll down the
list.
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Fig. 2.47: Selection of loaded tasks

2.3.8 Task information panel

The “Task information” panel includes the following tabs (Fig. 2.136):

• “Information”

• “Map”

• “Custom Fields”

• “History”

• “Relations”

• “Service Objects” (optional)
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2.3.8.1 “Information” tab

The “Information” tab contains the following detailed information about the task (Fig. 2.48):

• Task number;

• Contract number and name (if applicable);

• Task author;

• Time remaining until task deadline;

• Task title;

• Task description;

• Priority;

• Type of work;

• Task creation date;

• Organization and executor of the task;

• Task execution step;

• Creation date;

• Deadline for completion;

• Attached files (photos, audio files, video files, and documents).

If the task was created by the system according to a schedule, the “Information” tab also
contains the name of the schedule. You can navigate to the schedule card if you have the
rights to edit it.
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Fig. 2.48: “Task information” panel, “Information” tab.

The “Information” tab contains the task management panel, which includes the following
options:

• Include the task in the list of favorites for the current user.

• Assign/change task priority.

• Add a service object if it has not been assigned yet (only adding a new object is sup-
ported, editing or deleting the assigned service object is not possible).

• Assign/change type of work.

• Assign/change the organization responsible for executing the task.

• Assign/change the executor.

• Change the work step.

• Change the task status (refused, in progress, completed).
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• Delete the task (only users with administrative access rights have this capability).

A user with full permissions to edit tasks can change all the parameters of the task listed
above, except its creation date, as it is automatically generated and does not require editing.

To mark a task as a favorite for the current user, click on the star in the task card. Data is
sent to the server automatically. To save other changed parameters, click “Save” in the lower
right corner of the window.

In the upper left corner of the “Information” tab, to the left of the title with the task number,

there is a button that allows you to copy the link to the task to the clipboard. The link
contains the server address and task number.

In the upper right corner of the “Information” tab, the following buttons are located:

• “Reports” – opens the “Reports” window containing a list of reports with the “By
task” type. The reports listed are available to the authorized user for the types of work
in the selected tasks or for all types of work. In this window, the “Task” field auto-
matically displays the number of the current task (Fig. 2.49). To generate a report, set
its parameters and click the “Create report (pdf)” button or select excel/word2007/rtf
from the drop-down list depending on the required report format.

Fig. 2.49: Reports window called from the task card
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The “Ready reports” block displays the process of report generation. When the report is
ready, the file becomes available for viewing.

• “Print task” – opens a window with a report ready for printing, with detailed in-
formation about the task, including the values of the main and custom fields, photos,
map, and history of changes. You can set the display of the map with geolocation of the
task point and photos in ActiveMap Web: “Desktop application” -> “Print the tasks”
-> “Show the map”. You can send a report to a printer or save it in any convenient
format on the PC. (Fig. 2.50).

Fig. 2.50: Printing a task

Media files

At the bottom of the “Information” tab (Fig. 2.48), there is a field with attached files. It
contains the following tabs:

• “Photos”

• “Files”

• “Audio”

• “Video”

The tabs display all files attached to the task, including those added to custom fields of the
“File” format. The files are arranged in tabs according to format. A right-click on the tab
area outside of a file brings up a context menu that allows you to sort (Fig. 2.51) and group
files (Fig. 2.52) attached to the task, as well as copy and paste new files into the task. The
file grouping and sorting settings of the selected task are retained even when you switch to
this tab in the future.

2.3. User interface of the Program 36



ActiveMap Desktop user manual 3.44.0 (5.48)

Fig. 2.51: File sorting context menu

Fig. 2.52: File grouping context menu

To open a file, click on it.

At the bottom of the tab, there are “Add”, “Scan”, “Download”, and “Remove” buttons.
When you click the “Add” button, a window for selecting a file located on your personal
computer appears. After selecting the desired file and clicking the “Open” button, the Pro-
gram uploads the file and attaches it to the task.

When you click the “Scan” button (available only in the “Photos” tab), a window for select-
ing a scanning device opens. After selecting and configuring the scanning parameters, the
Program uploads the image and attaches it to the edited task.

The “Download” button allows you to save the file to a personal computer. The button
becomes active only after selecting a file. After clicking on it, a window for selecting the
directory for image saving appears.

The “Remove” button allows you to delete selected files from the task. In the media files
section of the “Information” tab, deletion is not available for files attached to custom fields
of the “File” format. You can delete such files only in the “Cust. Fields” tab.

Right-clicking on a file brings up a context menu offering save, copy, delete, get information
about the file, or move the file to a group. Deletion is not available for files attached to custom
fields of the “File” format. If there are several images in the “Photos” tab, an additional action
appears in the context menu, allowing you to set the main photo of the task (Fig. 2.53).

Fig. 2.53: File context menu
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If the photo is already the main one, this line is missing (Fig. 2.54). The main photo in the
task list area is marked with a checkmark. You can see the main photo in the task card in
the task list area. By default, the first photo added to the task becomes the main one, but you
can change it.

Fig. 2.54: Context menu of the main photo of the task

When using the built-in camera of the mobile application, the System records the date and
time of the photo, the time zone of the mobile device at the time of shooting, which are
overlaid on the photo (Fig. 2.57).

The System can also record information about BLE tags (beacons) if there are any in the
shooting location. A Bluetooth Low Energy (BLE) tag (beacon) is a wireless device that
uses Bluetooth low energy technology to send signals to nearby smart devices to determine
an object’s position relative to the beacon itself. When a user takes a photo of an object,
the ActiveMap Mobile application automatically records tag information and links it to the
photo. The mobile application determines the signal strength from different tags, and know-
ing their location, can determine the position indoors.

To display tags in the program you have to activate the work with BLE tags (beacons) in the
ActiveMap Web. Each tag has unique characteristics: UID (string) + major (int) + minor
(int). If a photo contains information about tags, you can see the bluetooth icon on it (Fig.
2.55).

Fig. 2.55: Icon indicating the presence of tag information in the photo

Tag information is displayed in the form of a table in the file information window (Fig. 2.56).
To open the information window, hover the cursor over the photo, right-click, and select the
“Information”.
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Fig. 2.56: File information window

Clicking on a photo opens a window for viewing images attached to the task (Fig. 2.57).
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Fig. 2.57: Image viewer window for task attachments

At the bottom of the window there are buttons that allow you to:

- zoom in.

- zoom out.

- go to the next image.

- go back to the previous image.

- rotate counterclockwise.

- rotate clockwise.

- open in the default Windows program for this file type.

In addition to these buttons, you can use the mouse wheel to zoom in and out in the viewing
window. The image viewing window can contain the following information:

• Image sticker is a text note on a photo. It is used to mark “before” and “after” statuses
in tasks, to highlight a sample for creating photos, and to group images in the view
window. The sticker name is displayed above the selected photo. If there are more
than 20 stickers, a search option for stickers appears in the file context menu.

• The “Used” and “Result” indicators allow you to see the links between the photo
and the sample it was taken on (Fig. 2.58).
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Fig. 2.58: Information about photolinks

• Statistics on the use of photo samples by sticker (Fig. 2.59). The calculation of
statistics starts when the photo link is created in the mobile app (if there is no link, the
icon is not displayed). The percentage of photos used as a photo sample is calculated
from the total number of photos with the given sticker in the task.

Fig. 2.59: Statistics on the use of photo angles

• Geolocation sign indicates that the task has coordinates. Hover over it to see the dis-
tance to the task point (Fig. 2.60). The color of the geolocation sign corresponds to the

distance of the photo from the geozones of the task point. Green means that image

coordinates are within the allowable radius, red – outside of it. By default, the
radius of the geozone is 150 m. You can change this value in the settings of ActiveMap
Desktop in ActiveMap Web – see more in the External settings (page 60) section.

Fig. 2.60: A photo with a geolocation tag

• Color indication of matching the tags in the photo and the tags in the photo sample
(Fig. 2.61).

2.3. User interface of the Program 41



ActiveMap Desktop user manual 3.44.0 (5.48)

Fig. 2.61: A photo with color indication of matching the tag UUID

• Green color – the tag with this UUID is present in both the sample and the current
photo.

• White color – the tag with this UUID is not found in the sample but is present in the
current photo.

• Red color – the tag with this UUID is present in the sample but is not found in the
current photo.

Tags are used to determine location. A match between the UUIDs of the tags attached to the
sample photo and the current photo (green row color) indicates that the photo was taken at
the same location as the sample.

• Rating of photo-result matching is carried out by a neural network. The green back-
ground color indicates the positive comparison percentage between two photos. You
can set the threshold values in the mobile application settings section on ActiveMap
Web. If values are not set or there is no access to the settings, the background color is
grey.
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Fig. 2.62: A photo with a rating of photo-result matching

Right-clicking a thumbnail or full-size image in the viewer opens a context menu with the
following options (Fig. 2.63):

Fig. 2.63: Context menu in the image viewer

• Create task – create a task based on this photo (for more information, see Creating
tasks using photos attached to a task (page 129)).

• Download – save the image to the user’s computer.

• Copy – copy the image to the clipboard.

• Remove – delete the image from the task.

• Information – open a file information window (Fig. 2.56).

• Move to group – assign one of the available stickers to the image. The following stickers
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are available by default: “Without sticker”, “Before”, “Sample”, or “After”.

Video files attached to the task can be of two types: normal video and timelapse video (time-
lapse) taken with the phone camera from the ActiveMap Mobile application. A timelapse is
a video created from the series of photos taken by a camera over a long period of time.

When capturing timelapses in ActiveMap Mobile, the geographical coordinates of the de-
vice’s movement are simultaneously recorded. So you can create tasks in the desktop app
with the image obtained from frames of this video and its geoposition attached. Timelapse
capture in the ActiveMap Mobile app becomes possible after enabling the appropriate set-
tings in ActiveMap Web (“Management” section -> “Settings” -> “Mobile App” -> “Time-
lapse Video Settings”).

You can view normal videos attached to the task only after downloading them. Use the
default Windows video player for such file types. For timelapse videos, you can view the
saved video in the built-in player. At the same time, you can see the motion track of the
device and its location at the time the current frame was recorded (Fig. 2.64).

Fig. 2.64: View a timelapse at the same time as the track

The window displays information about the actual duration, date, and time of the video
recording, as well as the ability to control the playback speed and create a task with frame
attachment.

If the recording was paused during shooting, this section is marked with red dots in the track.
In this case, the length of the video recording and its distance have two values: working
(including a pause) and total (without pause taken into account).

When viewing the video, you can create a task based on the current frame and its coordinates
on the video. To do this, click the “Create task” button on the menu panel. The task creation
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form opens. The video frame is added as a photo, and the coordinates of this frame become
the task location. See Creating tasks using a timelapse recorded in the ActiveMap Mobile
application (page 132) for more information on creating tasks based on a timelapse.

Invoice

The “Invoice” button is located next to the “Save” button in the lower right corner of the
“Info” tab. It allows you to generate an invoice during the task execution at the customer’s
site by creating a list of required materials and services with their quantities. The rights
to work with an invoice are configured in ActiveMap Web in the “Management” module,
“Settings” block, in the “Consumables accounting service” section. You can edit the values
of the reference table (dictionary) of materials and services in MapEditor or in ActiveMap
Desktop, in the “Layers and tables” menu section.

Clicking the button opens a web page where you can select the necessary materials and
services from the reference table (dictionary) and see their total cost (Fig. 2.65).

Fig. 2.65: Generating an invoice

To include materials and services in the estimate, click ‘Add item’ and select the required
item from the list. Here you can use the search bar and filter by group (Fig. 2.66). Click

to filter. A field for selecting the group of materials and services appears on the left.
Select one of the values from the drop-down list, click the plus sign to the right of the group
name, and then click “Apply”. The filtered list appears for selecting materials and services.
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Fig. 2.66: Filtering materials and services

After selecting, specify the quantity of each item. You can add new items to the reference
tables (dictionaries) of materials and services in MapEditor or in ActiveMap Desktop, in the
“Layers and tables” menu section.

The “Save” button allows you to save the list and quantity of selected materials and services
to the database without generating an invoice file. The “Generate invoice” button generates
and attaches an invoice in PDF format to the task (Fig. 2.67).
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Fig. 2.67: Invoice for printing

The generated invoice appears in the “Information” tab, “Files” section (Fig. 2.68).
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Fig. 2.68: Invoice attached to the task

2.3.8.2 “Map” tab

The “Map” tab allows you to view the address of the task, the places where the photo attached
to the task was taken, movement tracking of the task executor and the layers available to the
user (Fig. 2.69). If the users have the appropriate rights, they can add/modify the address
of a task location. To add/modify an address, mark the place on the map by double-click or
enter the address in the search field and click “Save”.
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Fig. 2.69: “Map” tab

In addition to the geo-referenced task and the attached photos, the map also shows the posi-
tion of the executor of this task with a time and date stamp. Above the map, you can see the
address and time of the executor’s location at that address.

At the top of the “Map” tab, there is a control panel for the executor’s track. By default,
the executor’s task data is displayed with a set period. The period corresponds to the date
of task creation and update. You can also manually configure and remember the period to
automatically display it when viewing the “Map” tab for all tasks. To do this, check the
corresponding box.

There are several buttons at the bottom of the map:

• – enables the display of geometric fields (Fig. 2.70) with the possi-
bility of editing them (adding geometry). This works if tasks have custom fields of the
“Geometry” type.
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Fig. 2.70: Displaying geometric fields

To enable the display of a particular field, select the checkbox next to its name.
buttons to the right of the name allow you to add point, line, and area objects on the map.
You can store only one geometry object in a field. When adding a second object, a message
appears confirming the replacement of the geometry (Fig. 2.71)

Fig. 2.71: Message about geometry replacement

The button allows you to clear the geometric field. The button displays information
about the geometric object: vertex coordinates, length/area for linear/planar objects, number
of vertices, name (by default – date of object creation), and description (Fig. 2.72).

Fig. 2.72: Information about a geometric object
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The buttons under the field names allow you to edit the object geometry:

– adds node. – moves node. – deletes node.

• – switches on the mode of displaying information on the selected object, for en-
abled layers (Layers -> Select the required layer).

Clicking on an object in the information display mode opens a window with a list of objects
found under the cursor (Fig. 2.73).

Fig. 2.73: Displaying layer object information

When you click to the right of the object name, the edit window opens. Here you can
edit the attributes and geometry, attach media files to the object (Fig. 2.74).
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Fig. 2.74: Layer object edit window

2.3.8.3 “Custom fields” tab

The “Custom fields” tab allows you to work with attribute fields that can be customized in
the system to suit the needs of the project and linked to the activities. Custom fields can
contain data of the following formats:

• integer;

• float;

• boolean;

• date;

• string;

• text;

• list;

• phone number;

• barcode (a numeric decoding of a barcode);
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• composite (a format that contains one or more nested fields and supports the creation
of multiple field instances in a task card);

• data objects (layer, data table, or reference table (dictionary) objects);

• geometry (geometric objects displayed in the “Map” tab);

• file (attached files of specified types).

You can specify a default value for all custom fields, except for the composite, geometry, and
file format fields. But you can set the default values for fields nested in a composite field.
Composite fields are used to add several similar sets of fields to a task, while the number
of sets is not known in advance. See Creating a task in the main window of the Program
(page 114) for more information about composite fields.

Each custom field with the “Data Objects” type corresponds to one layer, data table, or
reference table (dictionary). A task can have several fields of this format. Each field is
associated with its own layer, data table, or reference table. Display settings for a geometric
custom field specified when viewing one of the tasks, are saved when switching to another
task.

You can customize the order of displaying custom fields in a task in ActiveMap Web. If the
task has global and local fields, the group of global fields is displayed first, followed by the
local ones in the order defined in the system.

2.3.8.4 “History” tab

The “History” tab allows you to view information about the changes made and comments
added to the task in the form of messages. Messages can come from users or can be generated
by the system. To send a comment, enter the text and click “Add” or press the “Enter” key
(Fig. 2.75). To move the cursor to the next line, use the keyboard shortcut “Ctrl” + “Enter”.
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Fig. 2.75: “History” tab

When you hover the cursor over a message, the “Reply” button appears (Fig. 2.76).

Fig. 2.76: “Reply” button when hovering over a message

A right-click on a message brings up a contextual menu that also allows you to reply to the
message as well as copy its text (Fig. 2.77).
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Fig. 2.77: Message context menu

2.3.8.5 “Relations” tab

The “Relations” tab allows you to display and manage the link between the parent and child
tasks. At the bottom of the window, there are the following buttons (Fig. 2.78):

• “Create task” – creates a child task in relation to the current task.

• “Open” – opens the selected task in a new window.

• “Update” – updates information in this tab.

• “Remove” – deletes the task from the system.

• “Detach” – removes the link between the parent and child tasks.
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Fig. 2.78: “Relations” tab

After clicking the “Create task” button, a window appears where you can specify which data
to copy from the parent to the child.
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Fig. 2.79: Copying data from the parent task

2.3.8.6 “Service objects” tab

If a task has a link to a service object, a tab with the name of the layer associated with the
service object appears in the task card with information about the object (Fig. 2.80). In this
tab, you can enable or disable the display of empty fields.

Fig. 2.80: Service object tab

2.4 Program settings

Program settings are divided into internal and external. Internal settings are executed directly
in ActiveMap Desktop, external ones – in other software products of the ActiveMap (in
ActiveMap Web).
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2.4.1 Internal settings

To configure user settings within the Program, go to the “Options” menu section, select
“Settings”, the “Program Settings” tab. This opens the Program settings window, which
contains 2 tabs: “Main” and “Notification” (Fig. 2.81).

Fig. 2.81: “Settings” window, “Main” tab

You can enable the following flags (Fig. 2.81) in the “Main” tab:

• Minimize the program instead of closing.

• Use all organizations.

• Show geodata files.

• Show data about current users location.

• Hide inactive users on the map.

You can switch between the new and classic task list view (for more information, see Task list
area (page 27)), configure tasks sorting in the list area (by task number, by title, by creation
date, by completion date, by update date: in descending order or in ascending order).

To change the language of the Program, select one of the supported languages from the
drop-down list, click “Apply”, and restart the application. To add new languages to the
Program, upload a “.lang” file with the corresponding language to the “Localization” folder
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in the installed program directory. To generate a “.lang” file, use one of the existing files in
the “Localization” folder as a template. You can edit the file with any text editor (such as
“Notepad++”). The file contains all the words and phrases used in the Program. Replace
them with the words and phrases in the desired language. When saving a new file, its name
should have a similar format – “en-EN”. You can find a full list of language codes for
this format here: https://msdn.microsoft.com/en-us/library/ee825488(v=cs.20).aspx. After
a new file appears in the “Localization” folder, restart the Program.

In this window, you can also set compression parameters for images attached to tasks (size
and quality) and configure the task cache size. To apply the changes, click “Apply” at the
bottom of the window. To change the language settings you also need to restart the Program.
To discard changes, click the “Cancel” button.

In the “Notification” tab, you can manage sound notifications in the Program (Fig. 2.82).

Fig. 2.82: “Settings” window, “Notification” tab

The “Enable sound notifications” field allows you to activate notifications for all events in the
Program for which they are provided. In addition, you can configure individual categories
of sound notifications:

• About new user comment – when adding a comment from a user to a task (not a
system comment).

• About entering and leaving the zone – when a system comment about entering or
leaving the zone (task area) is added to the task (when the user to whom the tasks are

2.4. Program settings 59

https://msdn.microsoft.com/en-us/library/ee825488(v=cs.20).aspx


ActiveMap Desktop user manual 3.44.0 (5.48)

assigned arrived at the work site or left it).

• About changes in the task – when changes are made to tasks that meet the specified
criteria. The user can filter tasks by ticking the required fields, for example, marking
the organization, type of work and step. In this case, all other changes to the tasks are
not accompanied by a sound notification.

To apply the changes, click “Apply” at the bottom of the window. To discard changes, click
“Cancel”.

2.4.2 External settings

Some of the ActiveMap Desktop settings are configured in the associated software product
of the ActiveMap complex – ActiveMap Web. To do this, log in to ActiveMap Web and go
to the “Management” section, “Settings” block, and select the “Desktop application” (Fig.
2.83).

Fig. 2.83: ActiveMap Desktop settings in ActiveMap Web

The section contains folders and subfolders with the settings and their values.

To add a new setting for an element inside a section, click “+ Folder”, then “+ Setting”. Or
go to the folder of interest and click “+ Setting”. A form opens with the following fields to
fill in (Fig. 2.84):

• Key – the name of the setting in Latin characters for using in the system.

• Name – the name of the setting for displaying in the interface.

• Type – data type (string, integer number, logical value, or real number).
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Fig. 2.84: Creating a setting

To set a value for a setting, select the setting and click “+ Value”. This opens a window with
the following fields to fill in:

• Value – value the setting is equal to in the system (depends on the data type specified
when creating the setting).

• Organization – organizations to which this setting is applied.

• User – users to whom the setting is applied.

• Role – user roles to which the setting is applied.

• State – statuses of the task to which the setting is applied.

You cannot delete the basic settings. However, you can edit some of them. The availability
of editing is set in the database.

ActiveMap Desktop parameters configured in ActiveMap Web:

• Default values for:

– Type of work;

– Task title;

– Organization-creator;

– Priority;

– Task text;

• Plugin connection;

• Basemap of the application:

– Name of the folder for the cache;

– Projection of the basemap (in PROJ.4 format);
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– URL of TMS-service;

– Connection of available and primary base layers;

• ActiveMap Web layers displayed in ActiveMap Desktop (layer id);

• Task printing (map imagery in print form);

• Automatic filter application (TRUE/FALSE);

• Custom order of work types in lists (TRUE/FALSE);

• Photo capture radius for task area (in meters).

2.4.2.1 Default values

To specify the values to be filled in automatically during task creation, open the “Default
values” folder. The system allows configuring the following fields (Fig. 2.85) to be filled in
automatically:

• Type of work

• Title

• Creator organization

• Priority

• Task text

Fig. 2.85: Setting default values

Let us consider the process of setting new values for the “Work type” field as an example
(Fig. 2.86). To set a value for a setting, select it and click “+ Value”. Enter the work type
ID in the “Value” field and select the organization, user, role, and task status for which
the default value is used, from the drop-down lists. After filling in the values, click “Save”.
This way, when creating a task in ActiveMap Desktop, the “Work type” field is automatically
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filled in with the specified default value for users with an administrator role in the “Executor
Organization”.

Fig. 2.86: Setting a default value for the work type

To set the default values for other fields in this folder, follow the same steps.

2.4.2.2 Basemap of application

This folder contains the following fields (Fig. 2.87):

• Name of the folder for the cache – map cache folder for ActiveMap Desktop.

• Projection of basemap – basemap projection in PROJ.4 format.

• URL of TMS-service – link to the basemap layer.
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Fig. 2.87: Basemap settings

The system has basic settings for these fields. If necessary, you can enter your own values for
these parameters (similar to the process of setting new values, described in Default values
(page 62)).

The list of base layers available in ActiveMap Desktop is defined in ActiveMap Web in the
“Layers and tables” block. To connect a basemap in ActiveMap Desktop, you have to:

1. Go to the “Base layers” tab of the “Layers and tables” block, find the map of interest,
and click on the edit icon. The edit icon appears when you hover over the map name
(Fig. 2.88).

Fig. 2.88: List of base layers in ActiveMap Web, editing a map

2. Turn on the “Show” toggle for Desktop. To display the basemap by default, turn on the
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“Main” toggle (Fig. 2.89).

Fig. 2.89: Editing map parameters

2.4.2.3 Layers of web application

This setting allows you to select layers to be displayed on the map by default in the task
window (Fig. 2.90).
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Fig. 2.90: Configuring the display of ActiveMap Web layers in ActiveMap Desktop

To do this, select the setting and click “+ Value”. Enter the IDs of the required layers sepa-
rated by commas in the “Value” field (layers are displayed on the map in this order). Fill in
the remaining fields and click “Save”.

2.4.2.4 Plugins

In this folder you can connect additional plugins that expand the capabilities of working in
ActiveMap Desktop.

To connect a new plugin, you need to:

1. If there is no default “Plugins” folder in the “Desktop application” section, create it
with the following parameters:

• “key” field: “plugins”

• “name” field: “Plugins”

If the folder already exists, you can proceed directly to the second step.

2. Add the “Plugin name” setting and set a value for it (Fig. 2.91).

Setting parameters:

• “key” field: “name”

• “name” field: “Plugin Name”

• “type” field: “string”
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Fig. 2.91: Example of setting the plugin name

3. Add the “Enabled” setting to determine the need to download this plugin. Set the value
for the setting (Fig. 2.92). The setting can take two values, “True” or “False”. If no
value is specified, “False” is set by default.

Setting parameters:

• “key” field: “enabledPlugin”

• “name” field: “Enabled”

• “type” field: “boolean value”
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Fig. 2.92: Example of setting the plugin enabling

4. Add the “Version” setting to specify the version number of the plugin and set a value for
it (Fig. 2.93). If no value is specified, the latest version of the plugin will be installed.

Setting parameters:

• “key” field: “version”

• “name” field: “Version”

• “type” field: “string”

Fig. 2.93: Example of setting the plugin version
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2.4.2.5 Print the tasks

In this folder, you can set task printing options – whether to include a map in the printed task
form. By default, the map display is disabled (Fig. 2.94).

Fig. 2.94: Setting the map display when printing a task

2.4.2.6 Apply filters automatically

It is possible to set the system to automatically apply a filter to tasks. By default, this setting
is enabled (Fig. 2.95).

Fig. 2.95: Setting automatic filter
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To set a new value for the setting, select it and click “+ Value”. Turn on/off the toggle switch
in the opened window, fill in the remaining fields, and click “Save”. If you leave the switch
off and fill in the remaining fields, a value is created that limits the use of the automatic filter.
In this case, the user has to click “Apply” in ActiveMap Desktop to enable the filter.

2.4.2.7 Photo capture radius for task area

The system allows you to adjust the radius of the task area. The default radius is 150 meters
(Fig. 2.96). You can optionally set a new value (similar to the process of setting new values
described in Default values (page 62)).

Fig. 2.96: Setting the radius for the task area

2.5 Working with tabular data

Table is a set of related data stored in a structured form in a database. It consists of columns
and rows.

The system supports the following types of tabular data:

• layers

• data tables

• reference tables (dictionaries)

Layers differ from data tables and reference tables (dictionaries) by the presence of spatial
information about objects location (geometry, object coordinates). This allows you to display
them on the map. Data tables and dictionaries do not contain geometry. Reference tables
(dictionaries have a limit on the number of records. Loaded as drop-down lists, they are
used to make working with attribute information on objects easier. In addition to reference
tables (dictionaries) presented as editable tables, there are system reference tables. They
are generated automatically based on the data entered into the system (for example, tables
of users, types of work, and priorities). You can create and configure a link to a layer in
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ActiveMap Web. Use ActiveMap Desktop and MapEditor to edit reference or data table
values and fill in layer attributes.

To work with tabular data, go to the “Layers and tables” menu section. A window opens
with the following tabs: “Layers”, “Data table”, and “Dictionary” (Fig. 2.97). You can find
the required table using the search bar.

Fig. 2.97: “Layers and tables” window

2.5.1 Layers

In the “Layers” tab, you can enable the display of individual layers and their groups, select a
basemap (Fig. 2.98). The list of basemaps available for selection is configured in ActiveMap
Web. After marking the checkboxes in the “Layers” tab, the objects of the selected layer
appears in the “Task map” window, in the “Map” tab of the task information panel, as well
as in the windows of other layers.
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Fig. 2.98: “Layers and tables” window, “Layers” tab

To open the table view of a layer, double-click the highlighted line with the name of the layer

or click the button (Fig. 2.99).
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Fig. 2.99: Layer window

Among the layers, a group of service objects stands out. The principles of working with
layers are considered below using service objects as an example.

Service objects are layers that contain objects of interest of the user’s organization, associ-
ated with its activities. In ActiveMap Desktop, you can view all tasks attached to a specific
service object within a layer. When you attach tasks to such objects, the task fields are auto-
matically filled in according to the configured mapping (matching the layer attribute to the
task field). More information about creating tasks can be found in the Creating tasks in the
service object window (page 141) section.

You can work with service objects in the following menu sections:

1. “Layers and tables", “Layers” tab. To open the table view of the layer (Fig. 2.100),

double-click the highlighted line with the layer name or click .

2. “Service objects“. The section contains tabs with names of the service object layers
and a tab for importing a new table with objects from MS Excel. Switching to any of
the tabs with layer name opens a window with a list of objects of the selected layer and
a map with their location marks (Fig. 2.100).

This window allows you to edit, add, and delete objects, as well as to create tasks linked to
service objects. The window contains the following elements:

1. Menu;

2. Filter area;

3. Table with a list of objects;

4. Toolbar;

5. Map with object location marks and layers switched in the “Layers” menu section.
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Fig. 2.100: Service objects layer window

When you open the window for the first time, all layer objects are located in the visible
area of the map. You can move around the map using the buttons and the mouse wheel
and keyboard keys (arrows, “+” and “-” signs). When you close the layer window, the map
position is saved within the current session. This ensures that when you open the window
again, the map position remains the same.

2.5.1.1 Layer window menu

The layer window menu contains the following sections:

• “File”

• “Import”

• “Export”

• “Options”

If there are associated reports, an additional “Reports” section is displayed.

The “File” menu section includes the “Close” tab for closing the current window (Fig.
2.101).

Fig. 2.101: The “File” section of the layer window menu
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The “Import” menu section contains the following tabs (Fig. 2.102):

• “Import objects” — loads new objects into the current layer (for more details, see
Mass creation of new service objects (page 83)).

• “Update objects from MS Excel” — edits attributive information of layer objects in
bulk. To update the objects, first export them using the “Export data to MS Excel file”
option, then edit, save, and close the obtained file. After that you can start updating
objects (for more details, see Editing service objects (page 88)).

• “Save template with examples” — downloads a template with examples of layer ob-
jects. The coordinates in the examples are in the Longitude/Latitude coordinate system
on the WGS 84 ellipsoid – EPSG: 4326. They correspond to the centroid of the user’s
organization bounding box (for more details, see Mass creation of new service objects
(page 83)).

Fig. 2.102: The “Import” section of the layer window menu

The “Export” menu section includes an “Export data to MS Excel file” tab and allows you
to export table data into a MS Excel file for further use or editing in external programs (Fig.
2.103).

Fig. 2.103: The “Export” section of the layer window menu

The “Options” menu section contains the following tabs (Fig. 2.104):

• “Create tasks by all rows” — opens a window for mass creation of tasks for each
of the objects in the table (for more details, see Creating tasks in the service object
window (page 141)).

• “Delete objects by all in the list” — deletes all objects in the table (for more details,
see Copying existing service objects (page 87)).

• “Copy” — creates copies of selected objects in the table (for more details, see Deleting
service objects (page 93)).

Fig. 2.104: The “Options” section of the layer window menu

The “Reports” menu section opens the list of reports with the “By layers” type, linked to
this layer (for more details, see Reports in the layer window (page 78)).
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2.5.1.2 Map tools

In the upper left corner of the map there is a toolbar:

• — adds a new object to the map.

• — selects objects on the map using the cursor.

• — selects objects on the map by rectangle.

• — selects objects on the map by polygon.

• — enables the mode of displaying information on the selected object (the layer
should be turned on: “Layers -> Select a required layer”). For more information, see
“Map” tab (page 48).

• — fits objects into the map.

2.5.1.3 Filters in the layer window

You can use filters, sort table rows, and select objects on the map to make it easier to find
objects. You can specify several filtering conditions by adding ordinary and combined filters.
Combined filters establish priorities for conditions (similar to parentheses). To move to the

filtered results on the map, click on the toolbar.

Figure Fig. 2.105 shows an example of using ordinary filters.

Fig. 2.105: Result of using ordinary filters

Figure Fig. 2.106 shows an example of using a combined filter.

2.5. Working with tabular data 76



ActiveMap Desktop user manual 3.44.0 (5.48)

Fig. 2.106: The result of using a combined filter

To remove values entered in the filter field, click “Clear”. To completely reset the filter

conditions, click “Close” to the left of the filter. Then click “Apply” to display rows
with all objects in the table.

Use “Select on the map” , “Select on the map using rectangle” , and “Select on the

map using polygon” buttons to select objects on the map. They work as filters for the
list of objects. After selecting on the map, the table shows only rows with selected objects

(Fig. 2.107). To clear the results of the “Select on the map” filter, click “Close” next to
the red inscription “Selected on the map:”. In this case, only the data of the “Select on the
map” filter is cleared, the results of the main filter are saved.
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Fig. 2.107: Selecting objects on the map

2.5.1.4 Reports in the layer window

If there are reports linked to the layer, an additional “Reports” section is included in the layer
window menu. The authorized user should have rights to this report. To form a report in the
layer table, pre-select the objects of interest and click “Reports” (Fig. 2.108).

Fig. 2.108: Selecting objects to create a report
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A window opens with a list of available reports (Fig. 2.109). The IDs of the selected objects
appears in the input field of the opened window. If you want to generate a report for the
entire layer, you should select all rows in the table. You can also manually enter the IDs,
separated by a comma, in the “layer object id” field.

Fig. 2.109: Report window, field for entering object IDs

Next, click the “Create report” button. The “Generated reports” block will display the report
generation process. When the report is ready, the file becomes available for viewing (Fig.
2.110, Fig. 2.111).
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Fig. 2.110: Report, available for viewing

Fig. 2.111: Report on the number of tasks related to service objects

If there are fields for the object id in the report parameters, you can form a report for the
selected object in its card (Fig. 2.112).
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Fig. 2.112: The “Reports” section in the object card

2.5.1.5 Creating service objects

Both single creation and mass loading of new service objects is supported.
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Single creation of new service objects

To create a new service object, click “Add” at the bottom of the service object layer window

or mark the object’s position on the map using the tool. After performing any of these
actions, a window for creating a service object (Fig. 2.113) opens. The only difference is in
the absence or presence of the object mark on the map when you open the creation window.

Fig. 2.113: Service object creation window

In the creation window, do the following:

1. Fill in the available fields (including the object name). Text fields support multiline
input (use Enter to start a new line). Enter or select from the table or dropdown list,
if data tables or ordinary/system reference tables are attached to the layer. For more
information about tables, see Data tables and reference tables (dictionaries) (page 94)
section.

2. Mark/edit the object position on the map, or enter the coordinates of the object manu-

ally by clicking the button.

3. If necessary, you can attach files to the object, add links to pages (Fig. 2.114). You can
add files by dragging them from an open folder.
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Fig. 2.114: Adding a page

To complete the creation, click “Save”. The created object appears in the table and on the
map in the service objects layer window.

Mass creation of new service objects

Mass loading of objects can be done either by creating a new table or into an existing service
object layer. You can import both previously saved layer templates and original object data
files. To save the layer template, go to the “Import” section of the service object layer win-
dow, to the “Save template with examples” tab. A window for saving the template opens.
Fill in and save the received template. All standard file selection or save windows remember
the path so that you can reopen the same folder.

To bulk upload objects to a new table, go to the “Service objects” tab in the main program
window. Select the “Import from MS Excel” tab and choose the desired *.xlsx file. A
window with table creation settings opens (Fig. 2.115). By default, the Program defines a
worksheet from which data is imported, as well as the range to be loaded. You can specify
another range (the first row must be the header) and click “Recalculate”.

Next, in the preview window, match the file columns with the data type in the column and,
if available, select the field with the address or geometry (with geographic coordinates):

• Get coordinates by address (for point objects) — select a field in address format for
further automatic geocoding.

• Select a column in GeoJson format (for point, line, and polygon objects).

• Select the combined field of latitude and longitude (for point objects) – coordinates
must be separated by comma, with the integer part of the coordinates separated by a
dot.

You can use the same field both for specifying coordinates and for filling any layer field in
the import window via MS Excel file. If you clear the type of data for a column by clicking
the cross to the right of the data type name, the column will not be imported into the system.
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Fig. 2.115: Window with settings for importing a file into a new table, “Main” tab

The window contains 2 tabs: “Main” and “Style”. In the “Main” tab, specify the name of
the table being created and the header field, as well as determine the cluster and group to
which it belongs. By default, the table name is taken from the MS Excel file name, and the
first field with the “String” type is used as the header. You can change the default values.

In the “Style” tab (Fig. 2.116) you can select geometry type (point, line, polygon) and style
of displaying objects on the map (for point objects: geometric symbols shape, size, trans-
parency, main symbol, and stroke color; for linear: transparency, thickness, main line, and
stroke color; for polygonal: transparency, main figure, and stroke color).
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Fig. 2.116: Window with settings for importing a file into a new table, “Style” tab

After all the values are selected, click “Load” to start the import or “Close” to cancel. If
the “Load” button is not active, a message appears at the bottom of the window indicating
the reasons for the blocked state of the button. This message appears in the “Import/Update
Tasks”, “Import Excel Table”, and “Import/Update Objects” windows. Import is not possible
if the layer group is not specified (Fig. 2.117), or if there are multiple fields with the same
names in the imported table.
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Fig. 2.117: Import error – layer group not selected

After a successful import, the name of the new layer appears in the “Service Objects” tab.
Field mappings between the object and the task are automatically set up for this layer. The
task header is taken from the layer header. The object coordinates are copied into the task.
Other field mappings are configured separately. The current user uploaded the table has full
rights to view, edit, and manage the table. Default viewing rights for all user roles are also
provided.

To mass load objects into an existing service object layer, open the layer window, go to
“Import” section, “Import objects from MS Excel” tab and select the *.xlsx file of interest.
A preview window opens with file import settings (Fig. 2.118). Here you can specify sheets
and cell range to be imported, match file and layer columns, and select a field with an address
for automatic geocoding or geometry in one of the following formats: GeoJson (for point,
line, and polygonal objects), merged field or separate latitude and longitude fields (for point
objects).
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Fig. 2.118: Window with settings for importing a file into an existing layer

If the column names in the file and layer match, the program automatically maps them. You
can edit it manually. After specifying all the settings, click “Load” to start importing the
file. The uploaded objects appear in the service object window. To cancel the import, click
‘Close’.

Important: Column headers are read from the first row of the imported *.xlsx file. The
presence of headers is necessary for import.

Warning: Before starting to load data into ActiveMap Desktop you should close the
imported file if it is open in external programs.

Copying existing service objects

To create a copy of an existing service object, select it in the object list or on the map. Then
go to the “Options” section and select “Copy” in the current layer window (Fig. 2.119).

Fig. 2.119: Copying of service objects
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A message appears confirming the copy of the object data (Fig. 2.120). You can also enable
copying of files attached to the object here.

Fig. 2.120: Copying layer object data

After confirming the copy, a window for creating an object appears, where you can edit the
attribute information, location, add new or delete previously attached files. To complete the
copy, click “Save”. Click “Close” to cancel.

2.5.1.6 Editing service objects

Single service object editing

To edit a service object, double-click on the object name in the list. The object editing
window opens (Fig. 2.121).
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Fig. 2.121: Service object editing window, “Data” tab

The “Change” window contains the “Data” and “Assigned tasks” tabs. In addition to these,
there may be tabs with the name of related layers.

In the “Data” tab, you can edit the attribute data, geoposition of the object (by marking on
the map or entering new coordinates in the specified field if they are not entered earlier),
add a page, add, download or delete attached files using the context menu or buttons at the
bottom of the window. You can add files by dragging and dropping from an open folder. The
“Download” and “Delete” buttons become active after selecting one or more files.

The editability of attribute fields is set in the ActiveMap Web component. Non-editable
fields are displayed in the table and object card, but you cannot change the values of these
fields.

In the “Assigned tasks” tab, you can view and edit all tasks associated with a given service
object (Fig. 2.122). To make the search easier, you can use the filters on the left side of the
window.
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Fig. 2.122: Change service object window, “Assigned tasks” tab

If objects of the current (parent) layer are linked to the objects of another (child) layer, an
additional tab with the name of the linked layer appears in the “Change” window. There can
be several such layers (and tabs). An example of such linkage is the link between the pillar
layer and the equipment layer located on those pillars, between the park layer and the bins
placed in the park. The link between the layers is made by a field with data type “Layer”
which is set up in ActiveMap Web and which is filled in when the object is created in the
child layer. The tab with the name of the linked layer displays information about the linked
object (Fig. 2.123).
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Fig. 2.123: Change service object window, tab with linked layer name

There can be several related objects. To facilitate the search among a large number of objects,
you can use the filter.

The buttons common to all tabs of the window are:

• “Create task” – creates tasks with reference to the current service object (for more
details, see Creating tasks in the service object window (page 141)).

• “Save” – saves the changes made to the service object.

• “Close” – closes the change window.

Mass editing of service objects

For mass editing of service objects, follow these steps:

1. Go to the “Export” menu section of the service objects window and select the “Export
to MS Excel” item (Fig. 2.124). Enter the file name or leave the current one and click
the “Save” button.
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Fig. 2.124: The “Export” section of the layer window menu

2. Select the fields to export in the “Export settings” window (Fig. 2.125). For fields
linked to a layer or data table specify the type of data for export: id (Identifier) or
value (Meaning). The selected settings are saved within the user’s work session. After
selecting the required fields, click the “Export” button.

Fig. 2.125: Export settings window

3. Open and edit the file.

4. Go to the “Import” menu section of the service objects window, select the “Update
objects from MS Excel” and specify the edited file. A preview window opens (Fig.
2.126).
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Fig. 2.126: Window with settings for updating objects from MS Excel

5. Specify the sheets and cell range to import, and match the file and layer columns. If
the file and layer column names match, the Program automatically matches them. You
can edit them manually.

6. Select a field with an address for automatic geocoding or geometry in one of the fol-
lowing formats: GeoJson (for point, line, and polygon objects), a combined field or
separate latitude and longitude fields (for point objects). You can also enable deleting
additional field values when the cell values of the selected MS Excel table are empty.

7. Click “Load” to start importing the file with updated data. After confirming the upload,
the service objects will be updated in the table. To cancel the import, click “Close”.

Important: If there are non-editable fields in the table, their values will not be updated
even if there are changes in the *.xlsx file.

2.5.1.7 Deleting service objects

To delete a service object, select it in the list by clicking it or on the map by clicking the

“Select on map” button , “Select with a rectangle on the map” button or “Select with

a polygon on the map” button , and click “Delete” at the bottom of the window. You can
select multiple objects in the list by using the “Ctrl” and “Shift” keys or the combination
“Ctrl+A” to select all the objects in the list. After clicking “Delete,” a warning message
appears: “Do you really want to delete the selected record/selected objects?”. Click “Yes”
to delete, “No” to cancel.
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2.5.2 Data tables and reference tables (dictionaries)

Working with a table view of a reference table or a data table is similar to working with a
layer. To open it, find the table of interest in the “Layers and tables” window in the “Data ta-
ble” / “Dictionary” tab (manually or using the search bar). Then double-click the highlighted

line with the table name or click (Fig. 2.127).

Fig. 2.127: “Layers and tables” window, “Data table” tab

This opens a window (Fig. 2.128) that supports single record creation and editing, as well
as data import and export. In the data table window, you can also create tasks linked to table
objects. This option is not available in the reference table window.
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Fig. 2.128: Data table window

You can use the filter at the top of the window to select objects by parameters.

As a rule, data tables and dictionaries are associated with layers and are used to facilitate the
filling of attribute information when creating/editing a layer object. You can create a table
and set up a link to a layer in ActiveMap Web. Use ActiveMap Desktop and MapEditor to
edit the values of a table and fill in the layer attributes.

To fill in layer attributes with a configured link to a data table, click (Fig. 2.129). Select

the required value in the opened table, click (Fig. 2.130), and save the changes in
the object window.
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Fig. 2.129: Filling the attribute value associated with the data table

Fig. 2.130: Selecting a value from a linked data table
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To view information about the selected object of the linked data table, click . In the
opened window, a tab with the name of the associated layer(s) is available. Clicking on it
displays a list of objects that use the selected value (Fig. 2.131).

Fig. 2.131: Linked data table object window

When an attribute is linked to a reference table (ordinary or system), select a value from the
drop-down list and then save the changes in the object window (Fig. 2.132).
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Fig. 2.132: Selecting a value from a reference table (dictionary)

If an ordinary reference table is used, you can follow the link of this attribute (this option is
not available for a system reference table). The window of the value selected in the reference
table is displayed, as well as a tab with the name of the linked layer (or layers). The tab
contains a list of objects of this layer that use the selected value (Fig. 2.133).

2.5. Working with tabular data 98



ActiveMap Desktop user manual 3.44.0 (5.48)

Fig. 2.133: Reference table object window

2.6 Viewing and editing task information

The ability to edit tasks created on the server depends on the user’s role in the Program.
Most users have limited editing capabilities and can only edit certain task parameters (for
example, change the execution step, add media files and comments).

You can view information on an individual task and edit it in the following ways:

1. Enter the task number in the search bar and double-click the task preview (Fig. 2.134).
A separate task window opens (Fig. 2.135).
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Fig. 2.134: Task search and preview

2. Click in the task list area to open a separate window for viewing and editing
the task (Fig. 2.135).

Fig. 2.135: View detailed task information in a separate window

3. Double-click the task icon on the map to open a separate window for viewing and edit-
ing the task, similar to Fig. 2.135. Details on working with the task map are described
in the Task map (page 108) section.

4. Select a task in the task list area by clicking. You can see the task information on the
right side of the Program screen in the “Task Information” panel (Fig. 2.136).
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Fig. 2.136: Viewing detailed information about a task on the “Task Information” panel

See more about “Task Information” panel in the Task information panel (page 32) section.

Only this method (unlike the previous ones) allows you to get a link to the task and delete it.

After saving the task, the task list is automatically updated.

2.7 Operations on selected tasks

2.7.1 Task list

When one or more tasks are selected in the task list area (marked in a checkbox), buttons
for performing various operations on the selection become active in the lower right corner
of the list area. Clicking the “Edit selected” button opens a window where you can modify
the main and the custom fields of the task (Fig. 2.137). Checkboxes next to the editable
parameters activate drop-down lists with possible parameter values. After updating fields,
you can see the corresponding record in the task history, even if this field is not available for
a particular task, but it has been included in the update list during filtering.
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Fig. 2.137: “Edit selected tasks” window

Clicking the arrow to the right of the “Edit selected” button displays a drop-down list with
other operations (Fig. 2.138).

Fig. 2.138: Operations on selected tasks

• “Reports” – opens the “Reports” window containing a list of reports with the “By task”
type. The reports listed are available to the authorized user for the types of work in the
selected tasks or for all types of work. In this window, the “Task” field automatically
displays the numbers of the selected tasks. To generate a report, set its parameters and
click the “Create report (pdf)” button or select excel/word2007/rtf from the drop-down
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list depending on the required report format (Fig. 2.139).

Fig. 2.139: Reports window for selected tasks

• “Delete selected” – deletes selected tasks.

• “Print the tasks” – generates a report file containing detailed information for each of
the selected tasks. You can print the report or save it in any convenient format to a PC.

• “Export files” – uploads files attached to the tasks. When you click the button, a
window for browsing folders to save appears.

After selecting a folder, the task file grouping window opens. By default, files are grouped
and saved in folders with the number and name of the task (Fig. 2.140). In the preview
window, you can see the full paths of the files.
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Fig. 2.140: Task file grouping window

You can specify additional grouping by one or more task fields from the drop-down list and
by stickers. This allows you to create a more complex folder structure: folders with the name
and number of tasks are stored inside the folders with names of field values for grouping (Fig.
2.141).
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Fig. 2.141: Example of grouping task files by the “Types of work” field

• “Add to new schedule” – creates a new schedule including the selected tasks as tem-
plates. Clicking the appropriate list item opens the “Schedule creation” window (Fig.
2.142). The creation of schedules is described in the Creating schedules (page 144)
section.
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Fig. 2.142: “Schedule creation” window

• “Add to schedule” – adds the selected tasks to the existing schedule. Clicking the
button opens a window where you can select the schedule where the selected tasks are
included (Fig. 2.143), for more information, see Editing schedules (page 153).
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Fig. 2.143: Schedule list window

• “Change file stickers” – opens a window for reassigning stickers, where you can select
files with a sticker, assign a sticker to the marked file types (Fig. 2.144).

Fig. 2.144: “Reassigning stickers” window
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2.7.2 Task map

To work with tasks on the map, use the “Tasks map” button located on the task list panel in the
center of the Program screen. Clicking it opens the “Tasks map” window, displaying tasks,
enabled layers and System users on the map as different colored symbols corresponding to
the current status (Fig. 2.145).

Fig. 2.145: “Tasks map” window

To display the user on the map, configure the movement monitoring in ActiveMap Web. In
the right part of the window there is a user track panel, which allows you to monitor the
movement of executors for a certain period. You can configure and remember this period to
display it in the map window for all tasks.

In the upper left corner of the task window screen, there is a toolbar with the following
buttons:

• – moving around the map.

• – point selection of tasks on the map.

• – selection of tasks on the map with a rectangle.

• – selection of tasks on the map by a polygon.

• – task execution order.

• – activating the mode of displaying information on the selected object, provided
that the layer is enabled (Layers -> Select the required layer). The mode is described
in detail in “Map” tab (page 48).
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If you click the task selection button and double-click one of the tasks on the map, a window
with the task information appears. When multiple tasks are selected on the map, buttons
for operations on selections become active in the lower right corner of the window: “Edit
selected”, “Delete selected”, “Print tasks”, “Export files”. They work similarly to the buttons
described in the Task list area (page 27) section.

At the bottom of the window, you can enable/disable the display on the map of:

• users

• user captions

• task captions

• custom geometric fields

The following display options for captions are available:

• – task caption is not displayed.

• – task caption is displayed at a scale of 20000.

• – task caption is displayed at any scale.

The order of execution is implemented by changing the deadline for completing tasks. To
distribute the deadline for completing tasks, you have to:

1. Open the “Set deadlines” window (Fig. 2.146) by clicking the button.

Fig. 2.146: “Set deadlines” window
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2. Add tasks in one of the two ways described below:

2.1. Select multiple tasks on the map (Fig. 2.147).

Fig. 2.147: Distribution of task execution order

2.2. Or add tasks from the Main window:

2.2.1. In the “Set deadlines” window, clear the checkbox “Add when select in map” (Fig.
2.148).
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Fig. 2.148: Removing the “Add when select in map” flag

2.2.2. Switch to the main window, select a task (the selected task card turns blue) (Fig.
2.149)

Fig. 2.149: Selecting tasks

2.2.3. Click “Add” in the “Set deadlines” window (Fig. 2.150). Do the same steps for the
other tasks.
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Fig. 2.150: Distribution of the task execution order

3. Move the tasks within the list in the desired order using the up and down arrows

.

4. Set the interval:

4.1. Select date and time range (Fig. 2.151).

2.7. Operations on selected tasks 112



ActiveMap Desktop user manual 3.44.0 (5.48)

Fig. 2.151: Selecting the period of task execution

4.2. Click .

4.3. Confirm the actions (Fig. 2.152).

Fig. 2.152: Confirmation of changes

As a result, the Program distributes the task deadlines among the selected tasks within the
set time interval.

At the bottom of the window, the “Edit selected” button is duplicated (this button is also
located in the lower right corner of the task list area) (Fig. 2.153). Thus, you can select one
or several tasks on the map and apply mass changes to them, as well as delete or print them.
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Fig. 2.153: “Edit selected” button in the “Task map” window

2.8 Creating tasks

You can add new tasks to the system in the desktop component ActiveMap Desktop, in the
web component ActiveMap Web, and mobile application ActiveMap Mobile. The created
tasks are available in all components according to the access rights of an authorized user.

You can add new tasks to ActiveMap Desktop in one of the following ways:

• Using the “Create task” button on the “Task list” panel in the main window of the
Program;

• By uploading georeferenced photos;

• Based on a timelapse video taken in the ActiveMap Mobile application;

• Using an excel-table (mass creation of tasks);

• With linking to service objects.

2.8.1 Creating a task in the main window of the Program

To create a task in the main window of the Program, follow these steps:

1. Click the “Create task” button located in the task list area in the central part of the
screen (Fig. 2.154).

Fig. 2.154: “Create task” button.

2.8. Creating tasks 114



ActiveMap Desktop user manual 3.44.0 (5.48)

2. Fill in the basic fields in the “Create task” window (Fig. 2.155). By default, the fol-
lowing main fields are included:

• Title

• Priority

• Type of work

• Organization (executing organization)

• Executor

• Creation date

• Deadline

• Contract

• Creator organization

• Service object

• Text of the task

The “Creator organization” field is available only to users with the System Administrator
and System Inspector rights.

In addition to the main fields shown by default, the task creation window may include custom
fields.

Fig. 2.155: “Create task” window

You can select priority, type of work, organization (executing organization), executor, con-
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tract, and the creating organization from the drop-down lists. If the default value for the
executing organization is set in ActiveMap Web, you can left this field blank. The system
will fill it with the default value when saving the task.

The executor’s choice is available after selecting the organization from its employees. You

can also select the executor in the window that opens by clicking to the right of the field
(Fig. 2.156).

Fig. 2.156: Executor selection window

In this window, you can find previously assigned executors by filtering by completion dead-
line and creation date of assigned tasks, priority, organization, and type of work.

You can create tasks under a contract only during its validity period. A task is always cre-
ated within a contract cluster and assigned to the contract executing organization. If the task
executing organization is not specified, it is substituted. Users with the roles of System Ad-
ministrator, System Inspector, Cluster Administrator, Cluster Inspector, the Administrator
and Inspector of the executing organization can create a contract task, if the corresponding
option is enabled for the contract. The Administrator of the contracting organization can
create tasks based on service objects located in its organizations or cluster-level service ob-
jects. The contract may specify service objects and types of work for which you can create
tasks. If the list of service objects is not empty, you can create tasks only for objects in this
list. If the list of types of work is not empty, you can create tasks only using types from this
list.

For users with the Cluster Administrator and Cluster Inspector roles, automatic filling of the
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“Creator organization” field is supported. This field is filled with the user’s main organiza-
tion. If no main organization is specified, this field must be filled in manually.

When you place a cursor in the “Service object” field, a list of layers and tables marked as
service objects appears (Fig. 2.157).

Fig. 2.157: Extended search field for objects in layers

To include additional layers or data tables in the search, click the arrow. A drop-down list of

available items appears (Fig. 2.158). To exclude a layer or table from the search, click
next to its name.

Fig. 2.158: Full list of layers and data tables available for the object search

Clicking on the right side of the service object search field opens a separate window for
selecting the layer or table to search in. By default, only service object layers are enabled
(Fig. 2.159).
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Fig. 2.159: “Select layer” window

To select from the full list of layers and data tables, clear the “Only service objects” checkbox
(Fig. 2.160).
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Fig. 2.160: Displaying all searchable layers and tables

By double-clicking the layer/data table name or after selecting the name and clicking “Se-
lect”, the layer/data table window opens. Here you can find the object of interest (manually
or using filters). You can assign a service object even after creating a task. But you cannot
delete or edit the assigned service object in a task.

The mapping allows linking service object attributes to task fields. If these mappings are
configured in ActiveMap Web, the corresponding task fields are filled in automatically when
you select a service object. However, the priority in the task card is updated to the one
specified in the service object after saving the changes.

Important: Parameters marked with “*” are mandatory. If the “Save” button remains
inactive after filling in the fields, a red tooltip appears in the lower left corner of the task
creation window. It describes the reason for such behavior and gives advice on how to
correct it. This can occur if one of the mandatory fields is not filled in, or if the contract
and the type of work or the contractor organization do not match.

3. Fill in custom fields, if any. The set of custom fields is formed in the ActiveMap Web.
The following data types are supported:

• String – a short text;

• Text – an extended text;

• Integer number – an integer;
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• Real number – a real numeric value;

• Date and Time – date (day-month-year) and time (hours-minutes);

• Date only – date (day-month-year);

• Logical value – a choice from true and false options;

• Composite – a format that contains one or more nested fields and supports the creation
of multiple field instances in a task card;

• Selection from the list – a format with the possibility of specifying a list of options;

• Phone number – a format with the possibility of calling a specified number from the
task window;

• Barcode – a numeric decoding of barcode;

• Geometry – a format that contains information about the type of geometry (point, line,
polygon) and coordinates of one or several objects;

• Data Objects – links to objects of layers, data tables or reference table (dictionaries).

• File – a format for adding files.

Using a field with the “Data Objects” type, you can add one or more objects of a layer,
data table, or reference table to the task. Each custom field with the “Data Objects” type
corresponds to a single layer, data table, or reference table. One task can have several fields
of this format, connected to its own layer, data table, or reference table. The system supports
attaching the amount of an objects (configured in the ActiveMap Web).

When filling in the field with the “Data Objects” type, you can find the required object and
select it from the drop-down list using the search string (Fig. 2.161).
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Fig. 2.161: Searching for a data object

Clicking opens a table for single object selection. If the “Allow Multiselect” option is
not activated in the field settings, the search line will be hidden after selection. Clicking on
the selected object opens a card where you can view its attributes (Fig. 2.162).
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Fig. 2.162: Data object card

If the “Allow Multiselect” setting is activated, you can select several objects from the spec-
ified table in the custom field. Using the search line, you can find the required objects and

add them one at a time. To add objects in bulk, click . In the opened window, select
the required objects using the Shift and Ctrl keys and mouse buttons and click “Select” (Fig.
2.163).
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Fig. 2.163: Selecting multiple data objects

The selected objects appear in the task creation window. If the selected layer/table does not
have a title field, the object id is displayed in the custom field. When you click on the selected
object, a card opens where you can view its attributes. When you activate the “Allow add and
edit amount” setting, you can specify the quantitative characteristics of the selected object
(Fig. 2.164).
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Fig. 2.164: Entering the number of objects

Clicking “Open in table” (the number of objects is indicated in brackets) opens a table with
the objects selected in the task (Fig. 2.165).

Fig. 2.165: Table with objects attached to the task

If the user does not have rights to the added layer or table, then this custom field is displayed
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in the task card without the ability to edit it.

Composite fields are used to add several similar field sets to a task, with the number of
sets being unknown in advance. Composite fields are configured in ActiveMap Web. A
composite field contains one or more nested fields (Fig. 2.166).

Fig. 2.166: Adding composite fields

Nested fields can be marked as required and filled in by default. A nested field can also be
composite. This makes it a second-level composite field.

When creating a task, the default number of field instances specified in the settings is dis-
played in the task card. For example:

• If the minimum value is 0, only the composite field name and the “Add” button are
shown in the task card.

• If the minimum value is 3, three composite fields are displayed along with the name
and the “Add” button.

In the task card, users can add or remove composite fields, ensuring their number stays within
the defined minimum and maximum values. Once these limits are reached, the buttons
become inactive. If the minimum and maximum number of field instances are both set to 1,
you cannot add or remove the field. These rules apply to composite fields at both the first
and second levels.

If there are custom fields of the “File” format, you can attach files to the separate fields of the
task. Click the “Add” button under the field and select one of the formats from the dropdown
list. Fields are configured in the ActiveMap Web. You can add one or several file types in
the field depending on the settings (Fig. 2.167).
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Fig. 2.167: “File” format fields with different sets of supported file types

You can see the maximum possible number of files in this field in brackets, as well as the
current number of uploaded files. The number of attached files cannot exceed the set mini-
mum and maximum values. Once the maximum limit is reached, the “Add” button becomes
inactive. The same rule applies to the size of each file. If no limits are set, you can add any
number of files of any size.

The system supports the following file field formats: photo, video, sound, signature, QR
code, and file (for other file types). If the photo added to a custom field was the first one, it
becomes the main photo of the task. You can add a signature or QR code to a task only in the
ActiveMap Mobile iOS. After saving the task, signatures and QR codes become available
for viewing not only in the mobile app, but also in the desktop and web applications. If you
try to add a signature or QR code in ActiveMap Desktop, you will get a message stating that
this operation can only be performed via the mobile app (Fig. 2.168).

Fig. 2.168: Message indicating the operation is not supported

4. Specify the geographic location of the task in one of the following ways:

• Mark the location of the object by clicking on the map.
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• Enter the coordinates manually in the window that opens after clicking (Fig.
2.169).

Fig. 2.169: Window for entering task coordinates

• Enter the required address in the search field (Fig. 2.170).

Fig. 2.170: Linking an address to the task

5. If necessary, upload photos, audio, video, or other file types useful in the task execution
in the media files tab (Fig. 2.171). You can do it instead of attaching files to custom
fields of the “File” format or in addition to it.
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Fig. 2.171: Task window with an attached photo

6. Click “Save”. After that, the task is created and sent to the server. If you click “Save
and continue,” the task is also created and sent to the server, but the window remains
open for the subsequent task creation. You can see the created tasks in the general task
list.

2.8.2 Creating tasks by uploading geotagged photos

To create tasks by uploading geotagged photos, follow these steps:

1. Prepare a folder on your PC containing geotagged photos. The system creates a task
for each photo added to the folder.

2. Select the “Loading from GPS camera. . . ” tab in the “Options” menu.

3. Specify the following task parameters in the “Loading from GPS camera. . . ” window
(Fig. 2.172): “Title”, “Text of the task”, “Priority”, “Type”, and “Organization”.
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Fig. 2.172: Loading from a GPS camera

4. Click “Select folder” and navigate to the folder containing the geotagged photos to be
attached to the task.

The message “Loading is complete! A message was created” indicates the successful com-
pletion of the process. Created tasks appear in the general task list.

2.8.3 Creating tasks using photos attached to a task

To create a task based on an attached photo, follow these steps:

1. Open the previously created task with one or more photos attached. In the “Photos” tab,
click on the required photo. In the opened window, click “Create task” (Fig. 2.173).
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Fig. 2.173: Image view window

Alternatively, right-click on the thumbnail or full-size image in the viewing window and
select “Create task” from the context menu.

Fig. 2.174: Context menu in the image view window

2. Select the fields you want to copy to the new task and click “Yes”. If copying is not
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required, click “No” (Fig. 2.175).

Fig. 2.175: Selecting fields for copying

The task creation window opens with the photo attached. The task’s location is set to the
photo’s coordinates (if available).

3. In the task creation window, fill in the fields with the missing data, then click “Save”
(Fig. 2.176).

Fig. 2.176: Task creation window

The task is created and sent to the server. Then it appears in the general task list.
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2.8.4 Creating tasks using a timelapse recorded in the ActiveMap Mo-
bile application

To create new tasks based on a timelapse, follow these steps:

1. Go to the previously created task with the attached timelapse and double-click the
video icon. A player window opens, allowing you to simultaneously view the device’s
movement track and its location at the time the current frame was recorded (Fig. 2.177).

Fig. 2.177: Timelapse view window

2. Start playing the video or use the frame-by-frame navigation buttons to

reach the desired frame/location on the track, and then pause the playback . If
necessary, you can increase the playback speed by clicking one of the corresponding

buttons .

3. Click “Create task” at the bottom of the player window (Fig. 2.177). A task creation
form opens with a video frame added as a photo. The coordinates of this frame become
the task location.

2.8. Creating tasks 132



ActiveMap Desktop user manual 3.44.0 (5.48)

2.8.5 Mass task creation and updating using an Excel spreadsheet

2.8.5.1 Creating tasks using an Excel spreadsheet

You can create tasks in bulk based on a template or without one, using the original Excel
spreadsheet. To create new tasks based on a template, follow these steps:

1. Go to the “Options” menu section -> “Import” -> “Save template. . . ”. The template is
an Excel spreadsheet that includes both main and custom fields available to the current
user.

2. Fill in the obtained template. The first rows of the table show examples that you can
use to fill in the rest of the rows (Fig. 2.178). The coordinates in the examples are in the
Longitude/Latitude coordinate system on the WGS 84 ellipsoid – EPSG: 4326. They
correspond to the centroid of the user’s organization bounding box.

Fig. 2.178: Template for the mass task creation

When filling in the fields, remember the following:

1. The executor should belong to the assigned organization.

2. The custom fields should correspond to the selected work type.

If there is no such correspondence, an error will occur during the upload.

For the fields of “reference table (dictionary)” type, you can select values from the drop-
down list instead of entering them manually (Fig. 2.178). Custom fields with geometry, data
objects and composite custom fields are filled in as multi-line json.

Example of filled custom geometric field

{
""coordinates"": [
[
[
55.233264856570742,
25.210687181816144

],
[

(continues on next page)

2.8. Creating tasks 133



ActiveMap Desktop user manual 3.44.0 (5.48)

(continued from previous page)

55.23330777108324,
25.21047489619011

],
[
55.23318573293831,
25.210456595687567

],
[
55.233140136268773,
25.210670101377332

],
[
55.233264856570742,
25.210687181816144

]
]

],
""area"": 301.98,
""type"": ""Polygon"",
""name"": ""Work area"",
""pointsCount"": 4

}

Where:

• coordinates – pairs of vertex coordinates (longitude and latitude) in the WGS84 4326
coordinate system;

• distance/area – length/area of the object in km/sq km (for linear and polygonal objects,
respectively);

• type – geometry type (possible types: Polygon, LineString, MultiPoint);

• name – name of the object;

• pointsCount – number of vertices.

This example contains information about a polygonal object. In the task card, it looks like
this (Fig. 2.179):
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Fig. 2.179: Displaying a geometric field in the task card

Example of a filled custom field with data objects

{
""table_id"": 129,
""values"": [
{
""object_id"": 1,
""num"": 10.0,
""title"": ""Ceiling Mount AP""

},
{
""object_id"": 2,
""num"": 3.0,
""title"": ""Switch""

},
{
""object_id"": 5,
""num"": 2.0,
""title"": ""Gateway""

}
]

}

Where:

• table_id – table identifier.

• values – attached objects listed with their attributes within square brackets.

• object_id – object identifier in the table.

• num – quantitative attribute of the object (optional).
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• title – object title.

You can find the information for filling in the field with data objects in the layer or data table
(Fig. 2.180):

• table_id – number from the table header;

• object_id – value of the gid field for the selected object;

• title – value of the field used as the title (titles are configured in ActiveMap Web in the
“Layers and tables” block).

Fig. 2.180: Information required for filling the data objects field

This example contains information about 3 objects from the “Indoor equipment” table with
ID 129. Each object have a quantitative attribute indicating the number of items at the site
(10, 3, and 2). In the task card, it looks like this (Fig. 2.181):

Fig. 2.181: Fields with data objects in the task card

Example of a filled custom composite field

[
{
""guid"": ""750ba50a-0666-49dc-a3a2-1a7a5be8cd58"",
""On"": {

(continues on next page)
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(continued from previous page)

""field_id"": 116,
""value"": true

},
""ID"": {
""field_id"": 117,
""value"": 8815627

},
""Model"": {
""field_id"": 118,
""value"": {
""table_id"": 130,
""values"": [
{
""object_id"": 1,
""num"": null,
""title"": ""N300 Wireless N Outdoor Access Point""

}
]

}
}

},
{
""guid"": ""a3ad36d1-c8b4-48f7-b010-5402febe1c82"",
""On"": {
""field_id"": 116,
""value"": false

},
""ID"": {
""field_id"": 117,
""value"": 8815629

},
""Model"": {
""field_id"": 118,
""value"": {
""table_id"": 130,
""values"": [
{
""object_id"": 2,
""num"": null,
""title"": ""AC1200 Wireless MU-MIMO Gigabit Indoor/

→˓Outdoor Access Point""
}

]
}

}
}

]

Where:
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• guid – identifier of the composite field instance;

• On, ID, Model – names of nested fields;

• field_id – identifier of the nested field;

• value – value of the nested field.

You can find all the parameters except value by exporting tasks with the required number of
filled field instances. This example provides information about 2 instances of a composite
field with nested fields (On, ID, Model). Each of the nested fields has an identifier and a
field value. In the task card, it looks like this (Fig. 2.182):

Fig. 2.182: Composite fields in the task card

3. Save and close the edited Excel spreadsheet.

You can also upload the original *.xlsx file. The first row of the file should contain the
column headings.

To import the template or the original Excel spreadsheet, go to the “Options” menu -> “Im-
port” -> “Import tasks from MS Excel”, and choose the table you want to import. A preview
window opens (Fig. 2.183).
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Fig. 2.183: Preview window for importing tasks from MS Excel

When logging in under an account with the System Administrator role, select the corre-
sponding creator organization from the drop-down list. By default, the program determines
the worksheet from which data is imported, as well as the range for the upload. You can
specify a different range and click “Recalculate” (the first row must be the header). Next,
specify column correspondences in the preview window. If the column names match, the
application automatically sets correspondences for such columns.

To geolocate a task, select one of the suggested methods:

• Obtain coordinates by address (select the field for the geocoding from the drop-down
list).

• Choose the combined field of latitude and longitude (select the field that contains ge-

ometry in the specified format from the drop-down list (hovering over displays a
hint)).

• Choose the “Latitude” and “Longitude” fields (select the fields that contain geometry

in the specified format from the drop-down list (hovering over displays a hint)).

It is also possible to use the table field to specify the coordinates and to fill in the custom task
field at the same time. Once all the values have been marked, click “Load” to start import or
“Close” to cancel. If the button is inactive, a message appears at the bottom of the window
explaining why the button is disabled. This message is displayed in the “Import/update
tasks”, “Import from MS Excel” and “Import/update objects” windows. The import is not
possible if the imported table has multiple fields with the same name.

After confirming the upload, the import starts. New tasks appear in the general task list.
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2.8.5.2 Updating tasks using an Excel spreadsheet

To update tasks using an Excel spreadsheet, you should first export the existing tasks to a
*.xlsx file. Follow these steps:

1. Go to the “Options” menu -> “Export” -> “Export to MS Excel” or click the “Export

to MS Excel” button in the task list area.

2. Edit the table without changing the task IDs, the number of columns, and the column
names.

3. Save and close the edited Excel spreadsheet.

To import a table, go to the “Options” -> “Import” -> “Update tasks from MS Excel” and
select the desired table. A preview window opens (Fig. 2.184), similar to the window that
appears when importing tasks from MS Excel.

Fig. 2.184: Preview window for updating tasks from MS Excel

In this window, define the parameters described above. You can also enable the deletion of
custom fields if the selected MS Excel table cells are empty. Click “Load” to start importing
the file with the updated data, and “Close” to cancel the import. After confirming the upload,
the tasks are updated in the system.

Warning: Updating composite fields in tasks using an Excel spreadsheet is not sup-
ported.
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2.8.6 Creating tasks in the service object window

When creating tasks linked to service objects, the task fields are automatically filled in ac-
cording to the configured mapping (the correspondence between the layer attribute and the
task field). To create tasks linked to service objects, follow these steps:

1. Go to the “Service Objects” menu section and select the desired layer from the list. A
window opens with a list of objects in the selected layer and a map with their location
marks (Fig. 2.185).

Fig. 2.185: Service objects window

2. To create a task linked to a service object, first select the object of interest in the list

or on the map, after clicking the “Select on the map” , “Select rectangle on the

map” , or “Select polygon on the map” button . Then, the “Create task” button
becomes active in the bottom part of the window. Alternatively, double-click the object
name in the list and click the “Create task” button in the opened object window.

After clicking the “Create task” button, the task creation window opens with automatically
entered information about (Fig. 2.186):

• Task title (the field contains the name of the service object, it can be edited);

• Selected service object;

• Task coordinates that match the coordinates of the service object.

Fill in the remaining fields manually. You can see only the main task fields. Mandatory
fields are marked with an asterisk (*). After filling in the required fields, the “Save” and
“Save and continue” buttons become active. Click one of them to complete the task creation
process.
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Fig. 2.186: Task creation window linked to the service object

3. To create several tasks linked to different service objects, select the objects of interest

in the list using the “Shift” or “Ctrl” keys, or on the map using the rectangle or

polygon selection tool . Click “Create task”. If you need to create tasks linked to
all the service objects in the layer, go to the “Options” -> “Create tasks for all in the
list” tab in the service object layer window (Fig. 2.187).

Fig. 2.187: Creating tasks for all objects in the list

After performing any of these actions, the task creation window appears (Fig. 2.188).
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Fig. 2.188: Task creation window linked to service objects

The opened window specifies the service object layer and the number of selected objects for
creating tasks. You can fill in both the main and custom task fields. After selecting a task
type, the “Organization” and “Creating organization” fields show only those organizations
that have access to the marked task type, the others are hidden.

Important: When filling in the “Contracts” field, select only those service objects that are
listed in the contract. If the selected service objects are not listed in the contract, you cannot
create the tasks.

If the “Title” field is left blank, the titles of the created tasks are the same as those of the
linked service objects. If you leave this field blank, all created tasks have the same title. If
you leave the “Deadline” field blank, a default date (3 days) is automatically assigned.

Mandatory fields are marked with the symbol “*". After filling in the required fields, the
“Create” button becomes active. Created tasks appear in the general task list. The coordi-
nates of each of the tasks match the coordinates of the associated service objects.
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2.9 Working with schedules

Schedules allow you to automatically generate tasks based on templates at a certain time with
the required frequency. Task templates are the samples of tasks that are created according
to the schedule. Creating and editing schedules and task templates are available for the
following roles:

• System Administrator

• Cluster Administrator

• Organization Administrator

2.9.1 Creating schedules

To create a new schedule, go to the “Schedule list” window (“Schedules” -> “Schedules
management”) and click the “Create” button. Or select one or more tasks by checking the
box next to the task number in the task list. Then go to the “Schedules” -> “Add to new
schedule” menu section (or select the “Add to new schedule” operation from the dropdown
list in the bottom right corner of the task list area). The “Schedule creation” (Fig. 2.189)
window opens.
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Fig. 2.189: “Schedule creation” window

The window includes 3 areas:

1. Schedule parameters

2. Template list

3. Launch calendar

To create a new schedule, follow these steps:

1. Set its parameters:

• Name.

• Deadline (days, hours, minutes).

• Schedule enable flag – selecting the “On” checkbox makes the schedule active.

• Creation time – selected from the drop-down list. After selection you can adjust the
minutes value in the field. Click the “Add” button to apply it. The added time should
appear below the drop-down list. Time is counted according to the time zone assigned
to the organization’s cluster. If no organization is specified, the system creates tasks in
the current time zone.
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• Organization – selected from the drop-down list of organizations of the current cluster.
The user to whom the task is assigned should belong to the selected organization. If
the user does not belong to the organization, the task cannot be generated.

• Contract – selected from the drop-down list of available contracts. The schedule
according to the contract, like the contract itself, is created at the cluster level. If
you delete its contract in ActiveMap Web, the schedule is automatically considered as
deleted, but the tasks created according to this schedule are saved. If the schedule is
created according to the contract, the “Organization” field is not filled in. If the sched-
ule is not created according to the contract, you should select the organization. After
creating tasks according to the schedule with the attached contract, it is not possible to
change the service object or work type in them.

• Date of action – the date and time for the start and end of the schedule.

2. Select templates for creating tasks.

The template list area includes “Templates” and “Tasks for converting to templates” tabs.
The selected tasks are displayed in the second tab. At the bottom of the area, there are
buttons with operations that can be applied to selected templates and tasks for converting to
templates:

• “Change file stickers” – replaces photo stickers in tasks.

• “Create/Create a copy” – creates a new template or copy and edit one of the attached
(the operation is not available for tasks for converting to templates).

• “Open” – opens a template or task for converting into a template (if necessary, you can
edit and save the opened template/task).

• “Remove” – deletes a template or task for converting into a template.

After setting all the necessary parameters, click “Create”.

After the selected tasks are converted to templates, they no longer appear in the general list of
tasks. You can view and edit the templates by switching to the task templates mode (“View”
-> “Mode of work with task templates” menu section). In this mode, only templates are
displayed in the task list area. The message stating “You are working with task templates”
appears in the filter area. An additional “Schedule” parameter allows you to select templates
used in a specific schedule or in several schedules (Fig. 2.190).
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Fig. 2.190: Mode of working with task templates

To exit the mode of working with templates, click “To finish” button.

3. Set up launch dates and schedule cycles.

The system provides several options for scheduling: weekly, monthly, yearly, or any dates.
If the dates are set outside the schedule validity period, the tasks will not be created on these
dates.

If you select the “Weekly” option, a list opens where you can select the days of the week on
which tasks will be created during the validity period of the schedule (Fig. 2.191).

2.9. Working with schedules 147



ActiveMap Desktop user manual 3.44.0 (5.48)

Fig. 2.191: Activation of weekly schedule runs

Selecting the “Monthly” option opens the calendar for the month. Mark the dates to run the
schedule (Fig. 2.192). Tasks will be created on the specified dates monthly for the duration
of the schedule.
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Fig. 2.192: Activation of monthly schedule runs

Selecting the “Yearly” option opens a calendar for the year. Mark the dates to run the sched-
ule (Fig. 2.193). Tasks will be created on the specified dates every year for the duration of
the schedule.
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Fig. 2.193: Activation of yearly schedule runs

Selecting the “Any dates” option opens a calendar for the current year. Mark specific dates
to run the schedule (Fig. 2.194). Tasks will be created on the specified dates for the duration
of the schedule.
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Fig. 2.194: Activation of schedule runs on specific dates

If the data in different tabs overlap (for example, Monday and the 1st day), the system will
create a single task without duplication.

You can set non-working days when it is unnecessary to create schedule tasks. For example,
a holiday or vacation of an assigned employee. To do this, switch to the “Weekends” tab
after determining the periodicity of creating tasks. Similarly to working days, choose the
appropriate tab and mark the non-working days (Fig. 2.195). You can also set non-working
days in an already created schedule. In this case, the system removes the start time of tasks
on the specified days.
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Fig. 2.195: Setting non-working days

To view all task creation dates in the calendar before saving the schedule, click the “Preview”
button. The calendar window opens, showing all dates when tasks will be created. Non-
working days are highlighted in purple (Fig. 2.196).

2.9. Working with schedules 152



ActiveMap Desktop user manual 3.44.0 (5.48)

Fig. 2.196: Schedule preview

4. Click the “Create” button. The card of the created schedule appears in the general list
of schedules.

2.9.2 Editing schedules

To edit schedules, go to “Schedules” -> “Manage schedules” menu section. The “Schedule
list” (Fig. 2.197) window opens. Here you can create, search, edit, and delete schedules, and
view the results of template task launches. For users with the System Administrator, Cluster
Administrator, System Inspector, and Cluster Inspector roles, the list includes schedules of
all available clusters. Other users see only their cluster’s schedules.
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Fig. 2.197: “Schedule list” window

The window includes 3 areas:

1. Panel for filtering schedules

2. List of schedules

3. Launch calendar

Double-clicking a date in the calendar opens the list of launches for that day. (Fig. 2.198).
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Fig. 2.198: “Runs list” window

This window shows launches, templates used, and task steps. If a task has not been created,
a red icon with the number of tasks in the “Not created” step appears in the left part of the
window. Clicking this card displays the templates for created tasks on the right side of the
window. Here you can see the reasons why the task was not created (for example, if the type
of work, contract, organization, or executor does not match).

If the task was not created, you can restart the template creation. To do this, edit the selected
template and click “Restart”. If necessary, you can delete the template from the schedule. It
is also possible to edit the schedule itself by selecting it in the list of launches and clicking
“Edit”. The “Schedule change” window opens (Fig. 2.199). You can also open this window
by double-clicking the schedule of interest in the “Schedules list” window.
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Fig. 2.199: “Schedule change” window

In the opened window, you can change the name, deadline, time, and period of generating
launches, as well as select and edit the attached templates using the filter. You can open
a template by double-clicking on its card or by clicking on the card, and then clicking the
“Open” button at the bottom of the window. The “Open” button is activated after the card
is highlighted in blue.

The following mass operations over templates are supported:

• Edit selected.

• Change file stickers.

• Remove.

To perform mass operations, you should check the boxes on the cards of the templates you
are interested in and select one of the listed actions. In the current window, you can also
create a new template or copy and edit an existing one.

To edit existing schedules by adding tasks selected in the task list area to them, use the “Add
to schedule” operation from the drop-down list in the lower right corner of the task list area
(Fig. 2.200).
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Fig. 2.200: Adding tasks selected in the list area to the schedule

After clicking “Add to schedule”, the “Schedule list” window opens (Fig. 2.197). Here you
can select the schedule for including the selected tasks. To select a schedule from the list,
click on it and click “Select” (Fig. 2.201). You can use the filter bar on the left side of the
“Schedule list” window to make it easier to find the desired schedule.
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Fig. 2.201: Selecting a schedule for adding tasks

2.9.3 Exporting schedules

Schedule export involves downloading information about all tasks that will be created ac-
cording to the schedule during its lifetime.

To export a schedule, go to the “Schedules” -> “Schedules management” menu section. In

the opened window select a schedule by clicking on its card and click the export button
(Fig. 2.202).
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Fig. 2.202: Selecting a schedule for export

A window for selecting exported fields appears. It is similar to the task export window in
the main program window (Fig. 2.203). Here you should select the main and custom fields
for the export. You can automatically export only non-empty custom fields.
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Fig. 2.203: “Selecting exported fields” window

To save the set of task template fields selected for export, click “Add” , enter the name
of the set, and click “Save”. A message about the addition of a new export setting appears.
The name of the settings set is displayed in the dropdown list of saved configurations. If

necessary, you can edit , rename , or delete the saved set. The lists of settings in
the windows for exporting tasks in the main program window and exporting task templates
from the schedule do not overlap. They are displayed each in its own window.

After selecting the fields, click the “Export” button. A window for specifying the export
period appears (Fig. 2.204). By default, the validity period of the current schedule is used.
However, you can change it. Click “Apply” to start the export.
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Fig. 2.204: “Export period” window

The export result is an *.xlsx file (Fig. 2.205). It contains information about templates (in-
cluding main and custom fields) and schedule runs (start date and time, repeats for cyclic
schedules). Each row in the table contains information about one task created at the specified
time.

Fig. 2.205: Schedule export result

You can edit this file and use it to import a new schedule into the system (Importing schedules
(page 161)).

2.9.4 Importing schedules

The system supports importing *.xlsx files with information about tasks created according to
a schedule. You can obtain such a file by exporting an existing schedule with the possibility
of further editing the file (for more information, see Exporting schedules (page 158)).

To import a schedule, go to the “Schedules” -> “Import schedule” menu section and select
the table for import.

Warning: Before starting data upload to ActiveMap Desktop, close the imported file if
it is opened in external programs.

After selecting a file, a preview window appears (Fig. 2.206).
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Fig. 2.206: Preview window for schedule import

Here you can select the sheets, cell range and columns to import, match file columns and
task fields, and select a field with an address for automatic geocoding or geometry. User
with the System Administrator role have to specify the task creator organization. If the file
column names and task fields match, the Program makes an automatic comparison. You can
edit it manually. After specifying all the settings, click “Load”.

After that, the schedule import window opens (Fig. 2.207). Here you can change the automat-
ically assigned schedule name, creator organization and contract, date (period) of schedule
validity, as well as specify the deadline for completing tasks.

At the bottom of the window, you can see how many schedules will be created from this file.
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Fig. 2.207: “Import schedules” window

After specifying the listed values, click “Apply” to start importing the file. After successful
import, a corresponding information message appears (Fig. 2.208).

Fig. 2.208: Message about successful schedule creation

The new schedule is displayed at the top of the schedule list (Fig. 2.209). You can edit the
uploaded schedule.
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Fig. 2.209: New schedule in the list

Important: Cyclicity is not assigned when importing schedules from a table. You can
configure it after the import. Task runs are automatically registered in the “Any dates” tab
within the schedule validity period (Fig. 2.210).
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Fig. 2.210: Calendar of imported schedule launches

2.9.5 Deleting schedules

To delete a schedule, go to the “Schedules” -> “Schedules management” menu section. To
delete a single schedule, select it by clicking on the schedule card (Fig. 2.211) or by checking
the box in the card, and click “Delete”.
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Fig. 2.211: Selecting a schedule to delete

A message appears to confirm the deletion (Fig. 2.212). The number of schedules to be
deleted is indicated in parentheses.

Fig. 2.212: Confirming deletion of a schedule

To delete multiple schedules, check the boxes in the cards of the schedules you are interested
in and click the “Delete” button (Fig. 2.213).
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Fig. 2.213: Selecting multiple schedules to delete

A confirmation message appears with the number of schedules being deleted indicated in
parentheses (Fig. 2.214).

Fig. 2.214: Confirming deletion of multiple schedules

2.10 Completion of work

To exit the program (complete the work), close the window using the button located
in the upper right corner of the ActiveMap Desktop window, or click “Exit” in the “File” tab
on the toolbar.
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CHAPTER

THREE

FREQUENTLY ASKED QUESTIONS

3.1 Log in to the Program

If you are experiencing authorization problems, please check your internet connection. If you are con-
nected to the internet but the problem persists, contact the technical support hotline at the phone number
listed on the https://activemap.me/ website, or send an email to support@activemap.me.

3.2 Updating the Program

If you have a problem while updating ActiveMap Desktop, please check if another copy of the desktop
application is running. If it is running, close the application and try to update again. If the application is
not running or these actions do not help, disable your antivirus software and update again.

3.3 Photo from the task does not open in the Program

If you cannot open photos in the application, please check if you can open other images from any folder
on your computer. If they do not open, this problem may be related to the absence of an image viewer
application or a default image viewer not being set up. Install an image viewing program and/or set it as
the default viewer for used image and photo formats.

3.4 Planned tasks are not created

If a schedule has been created for tasks but they do not appear in the system at the specified time, check
whether the assigned executor belongs to the organization. If the executor does not belong to it, the task
generation becomes impossible. Change the executor or the organization in the task template attached to
the schedule.
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3.5 Impossible to import a service object layer or a task from MS
Excel

Before you start loading data into ActiveMap Desktop you should close the imported file if it is opened
in external programs. Column headings are read from the first line of the imported *.xlsx-file. Headings
are required for the import.

If the imported *.xlsx-file is opened in the import preview window, but the “Load” button is inactive,
red tips appear in the lower left corner of the window indicating the possible reasons for rejection. The
import is impossible if no layer group is specified or if the imported table has several fields with the same
names. Specify the group, delete the fields with duplicate names in the source file or exclude them from
the import by deleting the data type under the field names during previewing in the current window.

When importing tasks, remember that the executor should belong to the assigned organization, and the
additional fields should correspond to the selected type of work.
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CHAPTER

FOUR

GLOSSARY

Account is a set of data about a user stored in the system, necessary for the authentication and providing
access to personal data and settings.

Activation code is a file containing an encrypted hardware code, information about the number of users,
and the license period.

Applied software suite is a set of interconnected programs designed to solve problems of a certain class
of a particular subject area and interact with the user.

Attribute data are values describing features of the objects. Attribute data types are: integer, real, text,
date, date and time, geometry.

Band is an object that is placed directly on the report page. It is a container for the other objects, such
as “Text”, “Picture”, etc.

Basemap is the dominant or underlying layer in a given map that provides geographical context to the
map and other dataset layers above it. Users visualize tasks, service objects, and thematic layers above
the basemap. They use it for navigation through a map and for getting general information about the area
of interest.

Bluetooth Low Energy (BLE) tags, also known as beacons, is a class of Bluetooth Low Energy (LE)
devices that broadcast their identifier to nearby portable electronic devices. The identifier and several
bytes sent with it can be used to determine the device’s physical location, track customers, or trigger a
location-based action on the device.

Centroid is the center of a geographical object on a map. For most objects, the centroid coincides with
the center of the rectangle described around the object.

Client organization is an association of users who make their requests via the mobile application, mon-
itor their status, who are capable of evaluating the work performed. User rights for operating the System
are restricted.

Cluster is an association of several organizations for the purpose of enabling the in-process control of
the performance of departments.

Cluster Administrator is a user role in the System, responsible for administration of one or more speci-
fied clusters, namely: managing organizations and users, granting access rights to layers and reports, and
managing tasks.

Cluster Inspector is a user role in the System, responsible for managing tasks of one or more specified
clusters.

Clusterization is the representation of raster layer objects located nearby by a single label on a map.
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Composite field is a custom field format that contains one or more nested fields and supports the creation
of multiple field instances in a task card. It is used to add several similar field sets to the task, with the
number of sets being unknown in advance.

Contract is an entity for accounting and planning the task to be performed by organizations under con-
tractual obligations.

Custom fields are attribute fields, which can be customized in the system versus features of a project
underway, and be referenced to the certain work items.

Data export is a data loading from the Program database to an external file.

Data table is a set of the related data stored in a structured format in a database.

DBF data format is a data storage format used as one of the standard ways of storing and transmitting
information by database management systems, spreadsheets, etc.

Drag and Drop is a way to manipulate interface elements using a mouse or a touch screen. The method
is implemented by “grabbing” (pressing and holding the left mouse button) the object displayed on the
screen, which is available for such operation, and then moving it to another place (to change its location)
or “dropping” it to another element (to call the corresponding action in the program).

Executor is a user role for creating new tasks and performing the assigned tasks in the System.

GDAL (Geospatial Data Abstraction Library) is a translator library for raster and vector geospatial data
formats. As a library, it presents a single raster abstract data model and a single vector abstract data
model to the calling application for all supported formats.

Geographic coordinates are the mathematical values that designate a position on the earth relative to a
given reference system.

GeoJSON data format (Geographic JavaScript Object Notation) is a format for representing various
geographic data structures. A GeoJSON object can be represented by a geometry, a feature, or a feature
collection. GeoJSON supports the following geometry types: Point, LineString, Polygon, MultiPoint,
MultiLineString, MultiPolygon and GeometryCollection. A feature in GeoJSON consists of geometry
and additional properties. Feature collection consists of a set of features.

Geographic Information System (GIS) is an information system designed to collect, store, analyze,
and display spatial data and related information about presented GIS objects.

GPS is a satellite navigation system that measures distance, time and determines the location in the WGS
84 world coordinate system. It can accurately determine the three-dimensional coordinates of an object
equipped with a GPS receiver: latitude, longitude, height above sea level, as well as its speed, direction
of movement, and current time.

File label (sticker) is a textual mark in a picture.

Hardware code is a file that contains encrypted information about the server characteristics and the
license key.

Hatching is a set of drawings and colors used to fill polygonal objects.

Image sticker (file label) is a text mark on the photo.

Information display panel is a panel designed to display specific information related to user actions, as
well as messages that correct user actions (warning messages, tips).

Installer is a program that installs files on the end user’s computer.

Interval is a data table that is used to configure the display styles of layer objects on the map depending
on their specific numerical characteristics. The Program uses intervals of (a, b) type.
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Invitation (an invite link) is a link containing information on the server address, login, and password of
a user to simplify the process of authorization in the mobile application.

Layer is a visual representation of geographical data in the environment of any digital map.

Layer group is a set of layers grouped according to thematic or other specified criteria.

Layer object visibility on the map is a displaying the layer object on the map as a certain symbol, line,
or polygon.

Layer visibility on the map is a displaying of all layer objects on the map as a group of symbols, lines,
or polygons.

LDAP (Lightweight Directory Access Protocol) is an open, vendor-neutral, industry standard applica-
tion protocol for accessing and maintaining distributed directory information services over an Internet
Protocol (IP) network.

Legend is a set of symbols and explanations on a map.

License is a file containing information on the acceptable quantity of users and validity period, allowing
to link the server software of the System to the equipment.

License key is a character string provided to the customer by the software vendor after purchasing the
license, used to activate the product and obtain a digital license for a fixed server. Contains the maximum
number of users and the license period in an encrypted form.

Linear object is an object on a digital map that represents a place or item that has length but no area at
a given scale.

Managing map layers is the set of actions for managing layer visibility, creating and editing the geometry
of layer objects on the map.

Map scale is the ratio of a distance on a map to the corresponding distance on the ground. A scale of
1:100,000 means that one unit on the map corresponds to 100,000 of the same units of measurement on
the ground.

Mapping is a correspondence between a layer attribute and a task field.

MapInfo Interchange Format (MIF) is a MapInfo text data format that includes geographic data (ob-
jects) and a description of the data table containing attribute information related to objects.

Metadata is the information that describes the characteristics and properties of a particular layer.

Multi-object is a combination of several objects. Multi-objects can be of point, line, and polygon geo-
metric types.

Multiservice is the ability to represent any layer as a layer with service objects.

Node is the point representing the beginning or ending of an edge of a linear or polygonal object, topo-
logically linked to all the edges that meet there.

Object attributes (attribute data) are values describing the object properties. Attribute data types are:
integer, real, text, date and time, geometry.

Object geometry is the measurements and properties of points, lines and surfaces. In GIS, geometry
represents spatial components of geographic objects.

Object import is a data loading from external files into the Program database.

One-to-many relationship is a relation between two sets of data where one record in a parent table can
be associated with one or more records in another table (child data table).

172



ActiveMap Desktop user manual 3.44.0 (5.48)

Operational tasks are the tasks created to solve current issues.

Organization Administrator is a user role in the System, responsible for administering the organization,
namely: creating users, granting access rights to layers and reports within the organization, and managing
tasks of the organization.

Organization Inspector is a user role in the System, responsible for managing tasks within the organi-
zation.

Photo sample is a reference photo used as the basis for assessing similarity with a photo uploaded by
the user to confirm the completion of work on the service object.

Photo response is a photo uploaded by the executor to the task as a response to the attached photo sample
to confirm the completed work on the service object.

Point object is a cartographic object that does not have length or area in the accepted scale.

Polygonal (area) object is a cartographic object that bounds the area at a given scale.

Program user (User) is a person (employee) or organization that uses the current Program to perform a
specific function.

Raster layer represents data in the form of geographically-referenced images as well as fragments of
raster images displayed in the same projection and prepared for each level of map detail.

Reference table (dictionary) is a table with systematically organized data intended to help users to
handle attribute information on objects.

Service objects are the layers containing the objects of interest of the user organization due to their
relation to business activity of the involved organization. Service objects are used to set up tasks. They
contain the necessary information for the task execution.

Schedule is a tool that allow users to automatically create and assign template tasks at a certain time with
a specified periodicity.

SHP data format is a vector format of geographic files. It allows users to store the following types of
geometric objects: points (polypoints), lines (polylines), polygons, and other objects. A file can contain
only one object type. Each entry in the SHP file can have multiple attributes to describe its geometry.

Scheduled tasks are the tasks created at a specified date and time according to a template.

Spatial database is a database optimized to store and access spatial data or data that defines a geometric
space.

SQLite is an in-process library that implements a self-contained, serverless, zero-configuration, trans-
actional SQL database engine.

SQLite Data Format is the SQLite relational database file format.

Sub-object is an object included in the multi-object.

Symbol is a graphical representation of a geographic object or a class of spatial objects, which helps to
identify and distinguish them from other spatial objects on the map.

System Administrator is a user role in the System with the maximum rights, responsible for its config-
uration, including managing clusters, organizations, users of all roles, contracts, directories, as well as
for distributing access rights to layers and reports.

System Inspector is a user role in the System, responsible for managing tasks across all clusters.

System reference table is a reference table generated automatically based on data entered into the system.
System reference tables include tables of system users, priorities and types of work.
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TAB data format is the format of MapInfo vector spatial data files (MapInfo files).

Task is a system entity containing information about the type of work, creation date, deadline, priority,
execution step, contract, service object, as well as instructions for execution. It is possible to attach photo
samples, photo responses, and other auxiliary files (documents, photos, and videos) to the task.

Task priority is a characteristic of the urgency of the task.

Task status is a characteristic of the completion degree of work on the task, determined by the dispatcher
or administrator when accepting the task.

Task step is a stage in the sequence of actions for completing a task changed by the task executor, dis-
patcher, or automatically by the system according to the set algorithm.

Thematic layer is a spatial data bank layer which objects are interrelated by the same topic.

Tile (map tile) is one of many images that a map is divided into. Most map services use square tiles of
256x256 pixels.

Timelapse-video is a video file comprising a series of pictures taken via a video camera during a long
time period.

Tile Map Service (TMS) is a specification for storing and retrieving cartographic data that provides
access to the map tiles rendered at a specific scale level. These resources are accessed via the “REST”
interface.

Toolbar is a graphical user interface with buttons for performing Program commands.

Tiled Web Map Service (TWMS) is a specification for storing and retrieving map data that provides
pre-built georeferenced map images. TWMS relies on technologies for building and transmitting large
images to the Internet using tiles – small, standard-sized image fragments. A TWMS service may also
include one or more styles, dimensions, or tiling schemes to define how the TWMS layer is displayed.
Accessing data via the TWMS protocol requires preprocessing of the source cartographic data by creating
tiles for the full range of scales, over the entire area. This technology allows locally caching an image by
building a tile grid.

User profile is a characteristic of an individual system user, represented by a set of attributes, such as
full name, email, phone number, etc.

User rights management is a set of actions for registering and managing user rights in the Program.

User tags is an entity allowing to group users against a specified attribute (e.g., the phone model).

User type is a user characteristic (a human being or a vehicle) to determine the user mapping settings
versus the type selected.

Vector image is a representation of graphical objects and images based on the use of geometric primitives
such as points, lines, and polygons.

Webhook is an automated launching of http requests in response to operations on entities (comments
and tasks).

Web Feature Service (WFS) is a web service for querying spatial data that includes a standardized
API. Unlike the Web Map Service (WMS), which returns a map image (rendered data), the WFS service
returns actual objects with geometry and attributes that can be used in any type of geospatial analysis.
WFS services also support filters that allow users to perform spatial and attribute queries on the data.

Web Map Service (WMS) is a standard protocol for serving geographically referenced images over the
Internet, generated by a cartographic server based on data from the GIS database. The WMS service
may also include a Styled Layer Descriptor (SLD) to define how the WMS layer should be displayed.
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The WMS service layer consists of three elements arranged hierarchically in the table of contents. At
the top is the name of the WMS service, which contains all the layers of the WMS map. The next level
down contains the WMS composite layers whose only function is to organize the WMS sublayers into
appropriate groups. There is at least one WMS composite layer, but there can be any number of composite
WMS layers (and even nested groups within groups). WMS composite layers do not contain map layers.
This is the third group, WMS sublayers that actually contain map layers.
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task information panel, 32
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